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Installing the Operating System

Depending on the model, Microsoft Windows XP Home or Windows XP Professional is
preinstalled on the computer and will be configured automatically the first time the computer is
turned on.

fi CAUTION: Do not add optional hardware devices to your computer until the operating system is
successfully installed. Doing so may cause errors and may prevent the operating system from installing

properly.

A CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER UNTIL
THE PROCESS IS COMPLETE. Turning off the computer during the installation process might damage the
software that runs the computer.

1.1 Microsoft Windows XP

The first time the computer is turned on, Microsoft Windows is automatically installed. This
takes approximately 10 minutes, depending on the system hardware configuration. Read and
follow the instructions that appear on the screen to complete the installation. During this process,
do not turn off your computer unless you are directed to do so.

1.1.1 Installing or Upgrading Device Drivers

To install optional hardware devices after the OS installation is completed, you must install the
device drivers for the device you are installing.

The 1386 directory and its subdirectories provide the HP- or Compag-specific integration of the
operating system for the computer model and include device drivers supported by the operating
system.

When prompted for the I386 directory on the operating system CD, replace the path specification
with C:\I386 or use the Browse button of the dialog box to browse the computer for the 1386
folder. This action points to the appropriate drivers.

The latest support software is also available from the Web site at http://www.hp.com/support.
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Installing the Operating System

1.2 Converting to NTFS

1.2.1 Windows XP Home and XP Professional

The Windows XP Home and XP Professional operating systems handle only NTFS-formatted
drives. When installed, XP will, if necessary, automatically convert a FAT32 drive to NTFS.

1.3 HP Software

The Microsoft Windows XP Home or Windows XP Professional operating system is preinstalled
on the computer and will be configured automatically the first time the computer is turned on. All
other software is user-installed.

Certain drivers and utilities are available only in selected languages. You can obtain the latest
version of these files, in English and selected other languages, in one of these ways:

B HP web site at www.hp.com

B Restore Plus! CD, which is supplied with many HP models

% Additional HP software may be required in certain situations.
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Setup Utilities and Diagnostics Features

Setup Utilities (F10) and diagnostic features provide information needed about the computer
system when contacting Customer Support. These tools can also be used to:

B Change factory default settings and to set or change the system configuration, which may be
necessary when you add or remove hardware.

B Determine if all of the devices installed on the computer are recognized by the system and
functioning properly.

B Determine information about the operating environment of the computer.

B Solve system configuration errors detected but not automatically fixed during the Power-On
Self-Test (POST).

B Establish and manage passwords and other security features.

B Establish and manage energy-saving timeouts.

All features identified in this chapter may not be available on all HP products.

Power-On Self-Test (POST)

POST is a series of diagnostic tests that runs automatically when the system is turned on. POST
checks the following items to ensure that the computer system is functioning properly:

Keyboard
Memory modules
Diskette drives

All IDE (ATA) mass storage devices

Processors

B Controllers

If the Supervisor Password is set, a prompt appears on the screen while POST is running. You
will need to enter the password before continuing. Refer to Chapter 3, Section 3.1, “Initial
Configuration and Deployment,” for information on setting, deleting, or bypassing the password.

If POST finds an error in the system, an audible and/or visual message occurs. For POST error
messages and their solutions refer to Appendix C, “POST Error Messages.”
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2.2 Computer Setup Utilities
Use Computer Setup Ultilities (F10) to:

Modify or restore factory default settings.
Set the system date and time.

Set, view, change, or verify the system configuration including settings for processor,
graphics, memory, audio, storage, communications, and input devices.

Modity the boot order of bootable devices such as hard drives, diskette drives, optical drives,
or USB devices.

Configure the boot priority of IDE (ATA) hard drives.
The system is preset to always Quick Boot.

Enable or disable Network Server Mode, which allows the computer to boot the operating
system when the power-on password is enabled with or without a keyboard or mouse
attached. When attached to the system, the keyboard and mouse remain locked until the
power-on password is entered.

Enable supervisor password prompting during system restarts (warm boots) as well as during
power-on.

Establish a supervisor password that controls access to Computer Setup (F10) Utility and the
settings described in this section.

Secure the integrated I/O functionality, including the serial, USB, or parallel ports, audio, or
embedded NIC, so that they cannot be used until they are unsecured.

Enable or disable removable media boot ability.

Solve system configuration errors detected but not automatically fixed during the Power-On
Self-Test (POST).

Execute self-tests on a specified IDE (ATA) hard drive (when supported by the drive).

2.2.1 Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning on the computer or restarting the system. To
access the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer

Setup. Press Enter to bypass the title screen, if necessary.

% If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. A choice of headings appears in the Computer Setup Utilities menu: System Information,

Standard CMOS Features, Advanced BIOS Features, Advanced Chipset Features, Integrated
Peripherals, Power Management Setup, PnP/PCI Configurations, PC Health Status, Load
Optimized Defaults, Set Supervisor Password, Set User Password, Save and Exit Setup, and
Exit Without Saving.

2-2
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4. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and
down) keys to select the option you want, then press Enter. To return to the Computer Setup
Utilities menu, press Esc.

5. To apply and save changes, select Save and Exit Setup.
1 If you have made changes that you do not want applied, select Exit Without Saving.

1 Toreset to factory settings, select Load Optimized Defaults. This option will restore the
original factory system defaults. You must still select Save and Exit Setup after
resetting the defaults.

CAUTION: Do NOT turn the computer power OFF while the ROM is saving your F10 Computer Setup
changes because the CMOS could become corrupted. It is safe to turn off all power to the computer after
you exit the F10 Setup screen.
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2.2.2 Computer Setup Menu

Heading Option Description

System None Lists product name, SKU number, processor type, processor
Information speed, CPU ID, cache size, memory size, system ROM,

integrated MAC, UUID, system serial number, asset tracking
number, asset tag number, and CPU clock ratio.

Standard Date (mm/dd/yy)  Allows you to set system date.
FCMOS Time (hh:mm:ss) Allows you to set system time.
eatures

PATA Controller Disables/enables PATA controller.

PATA Ch O Master * For each, if PATA HDD is used, allows you to:
PATA Ch O Slave * run SMART HDD self-test for selected channel

* SMART Status Check
—Target Disk
-SMART
—Smart Status Check

* HDD Short Self-Test
— Target Disk
— Estimated Test Time
— Start Test

HDD Extended Self-Test
— Target Disk

— Estimated Test Time

— Start Test

set device details on selected channel to:
—None

-Auto

~Manual

set access mode on selected channel to:
~CHS (Cylinder-Head-Sector)

-LBA (Logical Block Addressing)

—Llarge

—Auto

* view
—Firmware version
—Capacity
—Cylinder
-Head
—Precomp
-Llanding Zone
—Sector
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Heading Option Description
Standard SATA Controller Disables/enables onboard SATA controller.
IC::MOS SATA Ch 1 Master  For each, allows you to:

eatures

(continued) SATA Ch 2 Master

* run HDD self-test for selected channel:

* SMART Status Check
~Target Disk

—SMART

—SMART Status Check
HDD Short Self-Test
—Target Disk
—Estimated Test Time
—Start Test

HDD Extended Self-Test
—Target Disk
—Estimated Test Time
—Start Test

* set extended IDE drive on selected channel to:

* None
* Auto
* set access mode on selected channel to
* large
* Auto
* view
* Firmware version
* Capacity
* Cylinder
*Head
* Precomp
* Landing Zone

* Sector

Floppy Controller

Disables/enables the floppy disc controller.

Drive A Allows you to set Drive A to None or 1.44, 3.5 in. (Used to
disable/enable Drive A in legacy operating systems.)
Halt On Allows you to set POST error behavior to:

* All Errors

* No Errors

* All but Keyboard

* All but Diskette

* All but Diskette/Keyboard

Service Reference Guide, dx2200 MT
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Heading Option Description
Standard POST Delay Allows you to set a POST delay to:
CMOS * 0 seconds
Features
(continued) * 5 seconds
* 10 seconds
* 15 seconds
* 30 seconds
Advanced Device Boot Allows you to restrict a device from booting the unit. You can
BIOS Features  Disabling disable as a bootable device:

* None

» USB

* Internal ODD

* Internal FDD

* USB + ODD + FDD

FQ Boot Menu

Disables/enables F? Boot Menu

Removable Device
Boot Priority

Allows you to specify the order of attached removable devices
(such as Legacy Floppy or USB FDD) The first drive in the order
has priority in the boot sequence and is recognized as drive A.

Hard Disk Boot
Seq.

Allows you to specify the order of attached hard drive devices
(such as USB HDD storage, USB2 Drive Key, or USB flash
media). The first drive in the order has priority in the boot
sequence and is recognized as drive C (if any devices are
attached).

Optical Drive Boot
Sequence

Allows you to specify the order in which attached optical drives
(including USB ODD) are checked for a bootable operating
system image.

Network Boot
Sequence

Allows you to specify the order in which network devices
(including UP NIC cards) are checked for a bootable operating
system image.

First Boot Device

Second Boot
Device

Third Boot Device
Fourth Boot Device

Allows you to specify which devices will boot first, second, third,
and fourth or to disable any of the three:

* Removable

* Hard Disk

* Optical Drive
* Network

* Disabled

MS-DOS drive lettering assignments may not apply after a
non-MS-DOS operating system has started.

Boot Up Numlock
Status

Allows you to set the default NumLock status to off or on.

2-6
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Heading Option Description
Advanced Security Option Allows you to set the security option to Setup or Always so that
BIOS Features the password is required every time the system boots or only

(continued)

when entering Computer Setup.

APIC Mode

Disables/enables the APIC mode.

MPS Version
Control for OS

Allows you to set the MPS table version to:
* 1.1
* 1.4

BIOS Write

Protection

Disables/enables BIOS upgrading.

Execute Disable Bit

Disables/enables Execute Disable Bit (XD) functionality, which
prevents malicious buffer overflow attacks.

Enhanced Intel

Enables/disables the primary display device:

SpeedStep
Technology
Advanced UMA Frame Buffer  Select the UMA (Unified Memory Architecture) frame buffer
Chipset size:
Features e 32MB
* 64MB
* Auto
Init Display First Allows you to select the primary display device:
(VGA SeHing) ¢ PCJ Slot
* OnChip VGA
* PCIEx
SURROUNDVIEW  Disables/enables SURROUNDVIEW (available when an ATI
PCIEx video card is installed).
AutoDetect PCI Clk  Disable/enable PCI clock auto-detection.
(VGA Setting)
Integrated Onboard HD Disables/enables onboard HD audio.
Peripherals Audio
OnChip USB Disables/enables USB controller.
Controller
USB Legacy Disables/enables USB legacy support function (USB keyboard,
Support USB mouse, and USB Drive Key).

Onboard LAN

Disables/enables onboard LAN controller.

Onboard LAN
Boot ROM

Disables/enables the boot ROM of the onboard LAN chip.

Service Reference Guide, dx2200 MT
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Heading Option Description
Integrated Onboard Serial Allows you to select a setting for the onboard serial port:
Peripherals Port « Disabled
(continued)
» 3F8/IRQ4
* 2F8/IRQ3
* 3E8/IRQ4
* 2E8/IRQ3
Onboard Parallel  Allows you to select a setting for the onboard parallel port:
Port * Disabled
» 378/IRQ7
» 278/IRQ5
* 3BC/IRQ7
Parallel Port Mode  Allows you to select parallel port mode:
» SPP
» EPP
* ECP
* ECP+EPP
* Normal
ECP Mode Use If Parallel Port Mode is set to ECP or ECP+EPP, allows you to set
DMA the DMA channel for ECP Mode to 1 or 3.
Power After AC Power Allows you to select system power loss behavior:
Management  Loss « On
Set
P » Off
* last State
ACPI Suspend ACPI sleep mode is S3 (Suspend To RAM)
Type
External Modem Disables/enables wake-up modem from S5.
S5 Wake-Up
RTC Alarm Resume  Disables/enables RTC alarm.
Date (of Month) If RTC Alarm Resume is enabled, allows you to select the day of
the month for resumption of RTC alarm. (Set to O for every day.)
Resume Time If RTC Alarm Resume is enabled, allows you to select what time
(hh:mm:ss) the RTC alarm will resume.
PnP/PCI Reset Disables/enables automatic reconfiguration.
Configurations CD:OFHQU“]“O” The default is Disabled. Select Enabled to reset Extended
ata

System Configuration Data (ESCD) when you exit Setup, if you
have installed a new add-on and the system reconfiguration has
caused such a serious conflict that the OS cannot boot.

2-8
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Heading Option

Description

Resources
Controlled By

Allows you to select whether resources are controlled
automatically or manually:

* Auto (ESCD-Extended Storage Configuration Data)
* Manual

BIOS can automatically configure all the bootable and Plug-
and-Play-compatible devices. If you choose Auto, you cannot
select IRQ, DMA and memory base address fields since BIOS
automatically assigns them.

IRQ Resources
* RQ-3
assigned to
* [RQ-4
assigned to
* [RQ-5
assigned to
* [RQ-7
assigned to
* IRQ-9
assigned to
* [RQ-10
assigned to
* [RQ-
1Tassigned to
* IRQ-12
assigned to
* [RQ-14
assigned to

* IRQ-15
assigned to

When resources are controlled manually, allows you to assign
each system interrupt a type, depending on the type of device
using the interrupt.

Legacy ISA for devices compliant with the original PC AT bus
specification, PCI/ISA PnP for devices compliant with the Plug-
and-Play standard whether designed for PCl or ISA bus
architecture.

Maximum Payload

Allows you to set TLP payload size for the PCI Express Devices

Size to (in bytes):
* 128
* 256
* 512
* 1024
* 2048
* 4096
PC Health System Fan Fail Disables/enables system fan detection during POST.
Status Check
Smart Fan Function  Disables/enables smart fan functionality.
Current CPU (view only)
Temperature
Service Reference Guide, dx2200 MT 415606-001 2-9
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Heading Option Description

Current System (view only)

Temperature

Current CPU Fan (view only)

Speed

Current System Fan  (view only)

Speed

Vcore (view only)

+12V (view only)

VCC5 (view only)

+3.3V (view only)

VBAT (V) (view only)

3VSB (V) (view only)
Load Allows you to reset Computer Setup to factory defaults.
Optimized
Defaults
Set Allows you to establish a password to control access to
Supervisor Computer Setup.
Password
Set User Allows you to establish a password to control access to the
Password computer. (Supervisor password must be set before you can set

a User password.)

Save & Exit Allows you to save current settings and exit Computer Setup.
Setup
Exit Without Allows you to exit Computer Setup without saving changes.
Saving

N Support for Computer Setup options may vary depending on your specific hardware configuration.
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2.3 Recovering the Configuration Settings

Recovering the configuration settings established in the Computer Setup (F10) Utility requires
that you first back up the settings before a recovery is needed.

The CMOS Save/Load utility firmware can be found at http://www.hp.com under the Software
& Driver Downloads for your specific model. Download the firmware files into a folder on a
removable storage device. It is recommended that you save any modified computer configuration
settings to a diskette, a USB flash media device, or a diskette-like device (a storage device set to
emulate a diskette drive) and save the diskette or device for possible future use.

2.3.1 Backing up the CMOS
1. Make sure the computer to be backed up is turned on. Connect the removable storage to the
computer.
2. Boot to DOS.

3. Type N:\folder\BIOS.exe SAVE:ABC001.DAT (where N is the drive letter of the removable
storage) to save the CMOS setting to the removable storage device.

2.3.2 Restoring the CMOS

1. Make sure the target computer is turned on. Connect the removable storage to the target
computer.

2. Boot to DOS.

3. Type N:\folder\BIOS.exe LOAD:ABC001.DAT (where N is the drive letter of the
removable storage) to load the custom CMOS setting onto the target system.

Service Reference Guide, dx2200 MT 415606-001 2-11
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Desktop Management

% Support for specific features described in this guide may vary by model or software version.

3.1 Initial Configuration and Deployment

HP computers come with a preinstalled system software image. After a brief software
“unbundling” process, the computer is ready to be used.

A customized software image may be deployed by installing additional software applications
after unbundling the preinstalled software image.

The best deployment method depends on your information technology environment and
processes. The PC Deployment section of the Solutions and Services Web site http://
h18000.www 1.hp.com/solutions/pcsolutions provides information to help you select the best
deployment method.

The Restore Plus! CD, ROM-based setup, and ACPI hardware provide further assistance with
recovery of system software, configuration management and troubleshooting, and power
management.

3.2 ROM Flash

The computer’s BIOS is stored in a programmable flash ROM (read only memory). By
establishing a supervisor password in the Computer Setup (F10) utility, you can protect the ROM
from being unintentionally updated or overwritten. This is important to ensure the operating
integrity of the computer. Should you need or want to upgrade the BIOS, you may download the
latest BIOS images from the HP driver and support page: http://www.hp.com/support.

CAUTION: For maximum ROM protection, be sure to establish a supervisor password. The supervisor
password prevents unauthorized ROM upgrades.

3.2.1 FailSafe Boot Block ROM

The FailSafe Boot Block ROM allows for system recovery in the unlikely event of a ROM flash
failure, for example, if a power failure were to occur during a ROM upgrade. The Boot Block is a
flash-protected section of the ROM that checks for a valid system ROM flash when power to the
system is turned on.

B If the system ROM is valid, the system starts normally.

B If the system ROM fails the validation check, the FailSafe Boot Block ROM provides
enough support to start the system from a bootable removable media that automatically
invokes system BIOS upgrade utilities.

To recover the system after it enters Boot Block recovery mode, complete the following steps:
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1. Remove all removable media and turn off the power.

2. Insert a diskette containing the desired BIOS image file in the root directory. The media must
be formatted using the FAT32 file system.

3. Turn on power to the system.

The failsafe Boot Block BIOS will attempt to start the system from a bootable device. If no
bootable device is found, an error message will appear.

4. Remove the removable media used to upgrade the BIOS.

5. Turn the power on to restart the computer.

3.2.2 Dual-State Power Button

With Advanced Configuration and Power Interface (ACPI) enabled for Windows XP, the power
button can function either as an on/off switch or as a suspend button. The suspend feature does
not completely turn off power, but instead causes the computer to enter a low-power standby.
This allows you to quickly power down without closing applications and to quickly return to the
same operational state without any data loss.

To change the power button’s configuration, complete the following steps:

1. Left click on the Start Button, then select Control Panel > Performance and
Maintenance > Power Options.

2. In the Power Options Properties, select the Advanced tab.
3. In the Power Button section, select the desired power button setting.

After configuring the power button to function as a suspend button, press the power button to put
the system in a very low power state (suspend). Press the button again to quickly bring the system
out of suspend to full power status. To completely turn off all power to the system, press and hold
the power button for four seconds.

CAUTION: Do not use the power button to turn off the computer unless the system is not responding;
turning off the power without operating system interaction could cause damage to or loss of data on the

hard drive.

3.2.3 Power Management

Power Management is a feature that saves energy by shutting down certain components of the
computer when they are not in use, thus saving energy without having to shut down the computer.

With Advanced Configuration and Power Interface (ACPI) enabled for Windows XP, timeouts
(the period of inactivity allowed before shutting down these components) can be enabled,
customized, or disabled using the operating system.

1. In Windows XP, left click on the Start Button, then select Control Panel > Power Options.
2. In the Power Options Properties, select the Power Schemes tab.
3. Select the desired power scheme settings.

Use Display Properties to establish, modify, or disable Power Management settings for the
monitor. To access Display Properties, right click on the Windows Desktop, then choose
Properties.
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3.2.4 World Wide Web Site

When making the transition to new or revised operating systems, it is important to implement the
support software designed for that operating system. If you plan to run a version of Microsoft
Windows that is different from the version included with your computer, you must install
corresponding device drivers and utilities to ensure that all features are supported and
functioning properly.

HP has made the task of locating, accessing, evaluating, and installing the latest support software
easier. You can download the software from http://www.hp.com/support. The Web site contains
the latest device drivers, utilities, and flashable ROM images needed to run the latest Microsoft
Windows operating system on your HP computer.

3.3 Security

3.3.1 Password Security

The user password prevents unauthorized use of the computer by requiring entry of a password to
access applications or data each time the computer is turned on or restarted. The supervisor
password specifically prevents unauthorized access to Computer Setup, and can also be used as
an override to the user password. That is, when prompted for the user password, entering the
supervisor password instead will allow access to the computer.

A network-wide setup password can be established to enable the system administrator to log in to
all network systems to perform maintenance without having to know the power-on password,
even if one has been established.

3.3.2 Establishing a Supervisor Password Using Computer
Setup

Establishing a supervisor password through Computer Setup prevents reconfiguration of the
computer (use of the Computer Setup (F10) utility) until the password is entered.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer
Setup. Press Enter to bypass the title screen, if necessary.

% If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

3. Select Set Supervisor Password and follow the instructions on the screen.

4. Before exiting, click Save and Exit Setup.

3.3.3 Establishing a User Password Using Computer Setup

Establishing a user password through Computer Setup prevents access to the computer when
power is turned on, unless the password is entered. When a user password is set, Computer Setup
presents Password Options under the Security menu. Password options include Password
Prompt on Warm Boot. When Password Prompt on Warm Boot is enabled, the password
must also be entered each time the computer is rebooted.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.
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2. As soon as the computer is turned on, press the F10 key to enter Computer Setup.

% If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Set User Password and follow the instructions on the screen.

4. Before exiting, click Save and Exit Setup.

Entering a User Password
To enter a user password, complete the following steps:
1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. When the prompt appears on the monitor, type your current password, then press Enter.

% Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, inclining beeping tones are heard. Try again.

Entering a Supervisor Password

If a supervisor password has been established on the computer, you will be prompted to enter it
each time you run Computer Setup.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press the F10 key to enter Computer Setup.

% If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. When the prompt appears on the monitor, type the supervisor password, then press the Enter
key.

% Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, inclining beeping tones are heard. Try again.

Changing a User or Supervisor Password
1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.
2. To change the user password, go to step 3.

To change the supervisor password, as soon as the computer is turned on, press the F10 key
to enter Computer Setup.
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% If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. When the prompt appears, type your current password, then select the desired
Set...Password item from the F10 headings. Then, enter the new password twice. Follow the
instructions on the screen.

Type carefully; for security reasons, the characters you type do not appear on the screen.

4. Press the Enter key.

The new password takes effect the next time you turn on the computer.

Deleting a User or Supervisor Password

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.
To delete the supervisor password, run Computer Setup.

2. To delete the password, as soon as the computer is turned on, press the F10 key to enter
Computer Setup.

If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. When the prompt appears, type your current password
current password

4. Press the Enter key then, select either Set User or Set Supervisor Password in the F10
menu as described in the previous sections.

5. When the prompt appears on the monitor press the Enter key twice. A message will appear
advising you that the password has been disabled.
Clearing Passwords
If you forget your password, you cannot access the computer. To clear the password:
1. Turn off and unplug the computer.
2. Remove the access panel.
3. Move the CMOS jumper from pins 2-3 to pins 1-2 and keep it there for at least 5 seconds.
4. Reset the jumper to pins 1-2 and replace the access panel.

5. Restart the computer.

3.3.4 Surge-Tolerant Power Supply

An integrated surge-tolerant power supply provides greater reliability when the computer is hit
with an unpredictable power surge. This power supply is rated to withstand a power surge of up
to 2000 volts without incurring any system downtime or data loss.
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4

Serial and Parallel ATA Drive Guidelines and
Features

Serial ATA = SATA
Parallel ATA = PATA

HP does not support the use of a PATA (IDE) hard drive on this model of computer.

4.1 SATA Hard Drives

Serial ATA Hard Drive Characteristics

Number of pins/conductors in data cable 7/7
Number of pins in power cable 15
Maximum data cable length 39.37 in (100 cm)
Data interface voltage differential 400-700 mV
Drive voltages 5V, 12V
Jumpers for configuring drive N/A

Data transfer rate 1.5 Gb/s

% When attaching the SATA cable to the system board always connect the primary hard drive to
SATA 0.
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4.2 SATA Hard Drive Cables

4.2.1 SATA Data Cable

Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the
SATA 1.5 Gb/s drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and
never bend it tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive. As
shown in the table, each cable has 3 grounds, and 4 transmit/receive pins.

Pin Number Usage Device Plug Host Plug
P1 Ground Ground Ground
p2* A+ Transmit data Receive data
P3* A- Transmit data Receive data
P4 Ground Ground Ground
p5** B- Receive data Transmit data
P&** B+ Receive data Transmit data
P7 Ground Ground Ground

*P2 and P3 differential signal pair
**P5 and Pé differential signal pair

4.2.2 SATA Power Cable

Pin Usage Notes Pin Usage Notes
P1 V3.3 3.3 V power PQ V5 5V power
P2 V3.3 3.3V power P10 Ground

P3 V3.3 3.3 V power P11 Ground

P4 Ground P12 Ground

P5 Ground P13 V12 12 V power
P6 Ground P14 V12 12 V power
P7 V5 5V power P15 Vvi2 12V power
P8 V5 5 V power
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4.3 PATA Device Information

This information applies to optical drives in a computer having one or two SATA drive
controllers and a single PATA drive controller.

PATA hard drives are not supported on these models.

4.4 PATA Cables
4.4.1 PATA Data Cable

Pin Signal Pin Signal Pin Signal
1 Reset 15 DD1 29 DMAK

2 Ground 16 DD14 30 Ground
3 DD7 17 DDO 31 INTRQ
4 DD8 18 DD15 32 IOCS16
5 DDé6 19 Ground 33 DA1

6 DD9 20 (Key) 34 PDIAG (cable detect)
7 DD5 21 DMARQ 35 DAO

8 DD10 22 Ground 36 DA2

9 DD4 23 DIOW 37 CS1FX
10 DD11 24 Ground 38 CS3FX
11 DD3 25 DIOR 39 DASP
12 DD12 26 Ground 40 Ground
13 DD2 27 IORDY

14 DD13 28 CSEL

4.4.2 PATA Power Cable

Pin Usage
1 +12V
2 Ground
3 Ground
4 +5V

4.5 PATA Drive Installation Guidelines

The computer system boards for these products have one Parallel ATA (PATA) channel with a
single connector. The channel can have up to two devices attached to it. All drives are connected
to the channel using an industry-standard 80-conductor cable.

% The industry-standard 1.44 MB diskette drive has its own separate channel and is not included as
a part of the maximum four ATA drives.
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4.5.1

4.6

4.7

Each drive attached to a channel must have a drive designation. If a drive is attached to the
Device 0 cable position and its cable-select jumper is present, the drive is designated as Device 0.
Similarly, if a drive is attached to the Device 1 cable position and its cable-select jumper is
present, the drive is designated as Device 1.

For optimal performance of a computer system, all drives need to be attached to the PATA
channel(s) in a specified sequence. This sequence is determined by the device class of the drives
and by specific attach sequence rules.

PATA Device Classes

In order to determine the best drive attach sequence, ATA/ATAPI drives are segregated into four
different classes based upon the bandwidth demands they place on an ATA channel. The most
demanding devices are in Class 1 and the least demanding are in Class 4.

Class 1 Class 2 Class 3 Class 4
Hard High Speed Optical Storage Magnetic
Drives Optical Drives Drives Storage Drives

Not DVD R/W CD-ROM Zip
Supported DVD-CD R/W CD-ROM

General Attach Guidelines

B The lower the device class number, the faster the device and the more bandwidth required.

B Drives installed in the Device 0 position receive the greatest possible bandwidth.

SATA SMART Drives

The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP
Personal Computers have built-in drive failure prediction that warns the user or network
administrator of an impending failure or crash of the hard drive. The SMART drive tracks fault
prediction and failure indication parameters such as reallocated sector count, spin retry count,
and calibration retry count. If the drive determines that a failure is imminent, it generates a fault
alert.

Drive Capacities

The combination of the file system and the operating system used in the computer determines the
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that
may be properly accessed by the operating system. A single hard drive may therefore be
subdivided into a number of unique drive partitions in order to make use of all of its space.

Because of the differences in the way that drive sizes are calculated, the size reported by the
operating system may differ from that marked on the hard drive or listed in the computer
specification. Drive size calculations by drive manufacturers are bytes to the base 10 while
calculations by Microsoft are bytes to the base 2.
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Drive/Partition Capacity Limits

Maximum Size

File Controller
System Type Operating System Partition Drive
FAT 32 ATA Windows 2000/ XP 32 GB 128 PB
NTFS ATA Windows NT/2000/XP 2 TB 128 PB

4.8 SATA BIOS

Windows 2000 and XP Windows 9x, NT, and Linux
Enhanced Mode (default BIOS Setting) Compatibility Mode (non-default BIOS Setting)
—Separate IDE controller —Combined IDE controller

* PATA Controller in Legacy Mode * PATA Controller in Legacy Mode
- Device 0O is accessible as Device O of - Device 0 is accessible as Device O of the
PATA controller’s Primary Channel combined controller’s Secondary
- Device 1 is accessible as Device 1of Channel
PATA controller’s Primary Channel - Device 1 is accessible as Device 1of the
« SATA Controller in Native Mode combined controller’s Secondary
- SATA 0 is accessible as Device O of Channel
SATA controller’s Primary Channel * SATA Controller in Legacy Mode
- SATA 1 is accessible as Device O of - SATA 0 is accessible as Device O of the
SATA controller’s Secondary Channel combined controller’s Primary Channel
SATA 2 is accessible as Device 1of - SATA 1 is inaccessible
SATA controller’s Primary Channel - SATA 2 is accessible as device 1 of the
- SATA 3 is accessible as Device 1 of combined controller’s Primary Channel
SATA controller’s Secondary Channel - SATA 3 is inaccessible

4.8.1 Legacy Mode

The Legacy mode is used to access devices attached to an embedded ATA controller. Each
channel of the controller requires two fixed I/O address ranges and an IRQ.

B Primary Channel
1 Command block: 1FOh - 1F7h
1  Control block: 3F6h
a IRQ: 14

B Secondary Channel
1 Command block: 170h - 177h
@  Control block: 376h
o IRQ: 15
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4.8.2 Native Mode

The native mode is used to access devices attached to additional ATA controllers and is not
supported by many legacy operating systems. Addresses are assigned by PCI Plug-n-Play BIOS
and the IRQ is shared with multiple controllers. Base Address Registers for the Command and

Control Block are found in the PCI Configuration Space.

Offset 10h—Primary Command base address
Offset 14h—Primary Control base address
Offset 18h—Secondary Command base address
Offset 1Ch—Secondary Control base address

4-6

415606-001

Service Reference Guide, dx2200 MT



5

Identifying the Chassis, Routine Care, and
Disassembly Preparation

This chapter provides general service information for the computer. Adherence to the procedures
and precautions described in this chapter is essential for proper service.

CAUTION: When the computer is plugged into an AC power source voltage is always applied to the
system board. You must disconnect the power cord from the power source before opening the computer
to prevent system board or component damage.

5.1 Chassis Designations

5.1.1 Microtower (MT)
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5.2

5.2.1

Electrostatic Discharge Information

A sudden discharge of static electricity from your finger or other conductor can destroy static-
sensitive devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs.
An electronic device exposed to electrostatic discharge (ESD) may not appear to be affected at
all and can work perfectly throughout a normal cycle. The device may function normally for a
while, but it has been degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the
discharge contains enough power to alter device parameters or melt silicon junctions.

Generating Static

The following table shows that:
B Different activities generate different amounts of static electricity.

B Static electricity increases as humidity decreases.

Relative Humidity

Event 55% 40% 10%
Walking across carpet 7,500 V 15,000 V 35,000 V
Walking across vinyl floor 3,000 V 5,000 V 12,000 V
Motions of bench worker 400V 800V 6,000V
Removing bubble pack from PCB 7,000 V 20,000 V 26,500 V
Packing PCBs in foam-lined box 5,000 V 11,000 V 21,000V

% 700 volts can degrade a product.

5.2.2 Preventing Electrostatic Damage to Equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the
degree of sensitivity. The following packaging and grounding precautions are necessary to
prevent damage to electric components and accessories.

B To avoid hand contact, transport products in static-safe containers such as tubes, bags, or
boxes.

B Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.

Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.
Place items on a grounded surface before removing them from their container.
Always be properly grounded when touching a sensitive component or assembly.

Avoid contact with pins, leads, or circuitry.

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or
conductive foam.
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5.2.3 Personal Grounding Methods and Equipment

Use the following equipment to prevent static electricity damage to equipment:

Wrist straps are flexible straps with a maximum of one-megohm + 10% resistance in the
ground cords. To provide proper ground, a strap must be worn snug against bare skin. The
ground cord must be connected and fit snugly into the banana plug connector on the
grounding mat or workstation.

Heel straps/Toe straps/Boot straps can be used at standing workstations and are
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats,
use them on both feet with a maximum of one-megohm + 10% resistance between the
operator and ground.

Static Shielding Protection Levels

Method Voltage

Antistatic plastic 1,500
Carbon-loaded plastic 7,500
Metallized laminate 15,000

5.2.4 Grounding the Work Area

To prevent static damage at the work area, use the following precautions:

Cover the work surface with approved static-dissipative material. Provide a wrist strap
connected to the work surface and properly grounded tools and equipment.

Use static-dissipative mats, foot straps, or air ionizers to give added protection.

Handle electrostatic sensitive components, parts, and assemblies by the case or PCB
laminate. Handle them only at static-free work areas.

Turn off power and input signals before inserting and removing connectors or test
equipment.

Use fixtures made of static-safe materials when fixtures must directly contact dissipative
surfaces.

Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

5.2.5 Recommended Materials and Equipment

Materials and equipment that are recommended for use in preventing static electricity include:

Antistatic tape

Antistatic smocks, aprons, or sleeve protectors

Conductive bins and other assembly or soldering aids

Conductive foam

Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance
Static-dissipative table or floor mats with hard tie to ground

Field service kits
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5.3

Static awareness labels

Wrist straps and footwear straps providing one-megohm +/- 10% resistance
Material handling packages

Conductive plastic bags

Conductive plastic tubes

Conductive tote boxes

Opaque shielding bags

Transparent metallized shielding bags

Transparent shielding tubes

Routine Care

5.3.1 General Cleaning Safety Precautions

1.
2.

3.
4.
5.
6.

Never use solvents or flammable solutions to clean the computer.

Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth
and then use the cloth on the component.

Always unplug the computer when cleaning with liquids or damp cloths.
Always unplug the computer before cleaning the keyboard, mouse, or air vents.
Disconnect the keyboard before cleaning it.

Wear safety glasses equipped with side shields when cleaning the keyboard.

5.3.2 Cleaning the Computer Case

Follow all safety precautions in Section 5.3.1, “General Cleaning Safety Precautions,” before
cleaning the computer.

To clean the computer case, follow the procedures described below:

To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it
with a cloth or swab dampened with clear water.

For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

After cleaning, always wipe the unit with a clean, lint-free cloth.

Occasionally clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.
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5.3.3 Cleaning the Keyboard

Follow all safety precautions in Section 5.3.1, “General Cleaning Safety Precautions,” before
cleaning the keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Section
5.3.2, “Cleaning the Computer Case.”

When cleaning debris from under the keys, review all rules in Section 5.3.1, “General Cleaning
Safety Precautions,” before following these procedures:

CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under

the keys.

B Visible debris underneath or between the keys may be removed by vacuuming or shaking.

B Canned, pressurized air may be used to clean debris from under the keys. Caution should be
used as too much air pressure can dislodge lubricants applied under the wide keys.

B If you remove a key, use a specially designed key puller to prevent damage to the keys. This

tool is available through many electronic supply outlets.

CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these keys are
improperly removed or installed, the keyboard may not function properly.

Cleaning under a key may be done with a swab moistened with isopropyl alcohol and
squeezed out. Be careful not to wipe away lubricants necessary for proper key functions. Use
tweezers to remove any fibers or dirt in confined areas. Allow the parts to air dry before
reassembly.

5.3.4 Cleaning the Monitor

Wipe the monitor screen with a clean cloth moistened with water or with a towelette
designed for cleaning monitors. Do not use sprays or aerosols directly on the screen; the
liquid may seep into the housing and damage a component. Never use solvents or flammable
liquids on the monitor.

To clean the monitor body follow the procedures in Section 5.3.2, “Cleaning the Computer
Case.”

5.3.5 Cleaning the Mouse

Before cleaning the mouse, ensure that the power to the computer is turned off.

Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull
out any debris from the ball socket, clean the rotating encoder shafts, and wipe the ball with
a clean, dry cloth before reassembly.

To clean the mouse body, follow the procedures in Section 5.3.2, “Cleaning the Computer
Case.”
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5.4 Service Considerations

Listed below are some of the considerations that you should keep in mind during the disassembly
and assembly of the computer.

5.4.1 Power Supply Fan

The power supply fan is a variable-speed fan based on the temperature in the power supply.

fi CAUTION: The cooling fan is on when the computer is “ON” or in “Suspend to RAM” modes.
The cooling fan is off when the computer is in “Dormant”, Suspend to Disk”, or “Soft Off” modes.
The cooling fan is always on when the computer is either in the “On,” “Standby,” or “Suspend” modes.

You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.

5.4.2 Tools and Software Requirements

To service the computer, you need the following:

B Torx T-15 screwdriver (Compaq screwdriver with bits, PN 161946-001)
B Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

B Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

B Diagnostics software

B Compaq tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or
Compagq tamper-resistant bits (Smart Cover FailSafe Key, PN 166527-002)

5.4.3 Screws

The screws used in the computer are not interchangeable. They may have standard or metric
threads and may be of different lengths. If an incorrect screw is used during the reassembly
process, it can damage the unit. HP strongly recommends that all screws removed during
disassembly be kept with the part that was removed, then returned to their proper locations.

Metric screws have a black finish.
U.S. (Unified Standard) screws have a silver finish and are only used on hard drives.

% As each subassembly is removed from the computer, it should be placed away from the work
area to prevent damage.
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5.4.4 Cables and Connectors

5.4.5

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with
care to avoid damage. Apply only the tension required to seat or unseat the cables during
insertion or removal from the connector. Handle cables by the connector whenever possible. In
all cases, avoid bending or twisting the cables, and ensure that the cables are routed in such a way
that they cannot be caught or snagged by parts being removed or replaced.

CAUTION: When servicing this computer, ensure that cables are placed in their proper location during
the reassembly process. Improper cable placement can damage the computer.

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration.
This applies to failed drives as well as replacement spares.

B If a drive must be mailed, place the drive in an HP approved hard drive shipping container or
other suitable protective packaging and label the package “Fragile: Handle With Care.”

B Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

B Avoid dropping drives from any height onto any surface.

B If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard
drive while the computer is on or in standby mode.

B Before handling a drive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector. For more information about preventing electrostatic
damage, refer to Section 5.2, “Electrostatic Discharge Information.”

B Do not use excessive force when inserting a drive.

B Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic
fields such as monitors or speakers.

5.4.6 Lithium Coin Cell Battery

A\

The battery that comes with the computer provides power to the real-time clock and has a
minimum lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this
guide for instructions on the replacement procedures.

WARNING: This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in
water or fire, or expose it to temperatures higher than 140°F (60°C).

CAUTION: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste.

Service Reference Guide, dx2200 MT 415606-001 5-7



Identifying the Chassis, Routine Care, and Disassembly Preparation

5-8 415606-001 Service Reference Guide, dx2200 MT



6

Removal and Replacement Procedures—
icrotower (MT) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper
service. After completing all necessary removal and replacement procedures, run the Diagnostics
utility to verify that all components operate properly.

% Not all features listed in this guide are available on all computers.

6.1 Preparation for Disassembly

See Chapter 5, “Identifying the Chassis, Routine Care, and Disassembly Preparation,” for initial
procedures.

1. Close any open software applications.
2. Exit the operating system.
3. Remove any diskette or compact disc from the computer.

4. Turn off the computer and any peripheral devices that are connected to it.

CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as
the system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be disconnected
before servicing a unit.

fi CAUTION: Turn off the computer before disconnecting any cables.

5. Disconnect the power cord from the electrical outlet and then from the computer.

6. Disconnect all peripheral device cables from the computer.

% During disassembly, label each cable as you remove it, noting its position and routing. Keep all
screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong
screw in an application may damage the unit.
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6.2 Access Panel

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

CAUTION: Before removing the computer access panel, ensure that the computer is turned off and that
the power cord is disconnected from the electrical outlet.

2. Disconnect the power cord from the computer and from the power source @.
3. Remove the two screws that secure the access panel to the computer chassis @.

4. Slide the access panel back about 6 mm (1/4 inch), then rotate the top of the panel away from
the chassis (pivot on the bottom) and lift it off the unit ©.

To replace the access panel, reverse the removal steps.

6-2 415606-001 Service Reference Guide, dx2200 MT



Removal and Replacement Procedures— Microtower (MT) Chassis

6.3 Front Bezel

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove the access panel (Section 6.2, “Access Panel”).

3. Pull outward on all three tabs on the left side of the bezel @ then rotate the bezel off the
chassis @, beginning with the left side then the right side.

To reinstall the front bezel, reverse the removal procedure.
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6.4 Front Drive Bezels

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove the access panel (Section 6.3, “Front Bezel”).

3. Remove the front bezel (Section 6.3, “Front Bezel”).

6.4.1 5.25" Drive Bezel Blank

While facing the inside of the front bezel, press the two retaining tabs on the right towards the
outer edge of the bezel @ and pull the bezel blank inwards to remove it @.

To install a bezel blank, slide the left side of the blank into the two retainer slots on the left side
of the front bezel then snap the right side of the blank into place.
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6.4.2 Removing a 3.5” Drive Bezel Blank

While facing the inside of the front bezel, press outward on the retaining tabs on each side of the
bezel blank @ and pull the bezel blank inwards to remove it @.

To install a 3.5” bezel blank, press the blank inward from the inside of the front bezel so that it
snaps into place.
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6.5 Memory

For more information on the memory in this series of computers, refer to Appendix D,
“Memory.”

6.5.1 Installing Memory Modules

CAUTION: The memory module sockets have gold metal contacts. When upgrading the memory, it is
important fo use memory modules with gold metal contacts to prevent corrosion and/or oxidation
resulting from having incompatible metals in contact with each other.

CAUTION: Static electricity can damage the electronic components of the computer or optional cards.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly touching
a grounded metal object. Refer to Chapter 5 for more information.

CAUTION: When handling a memory module, be careful not to touch any of the contacts. Doing so
may damage the module.

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel (Section 6.2, “Access Panel”).

WARNING: To reduce risk of personal injury from hot surfaces, allow the internal system components to
cool before touching.

3. Lay the computer down on its side to make it easier to work on.

4. Open both latches of the memory module socket @, and insert the memory module into the
socket @. Begin by installing a module into the socket nearest the preinstalled module, and
install the modules following the numerical order of the sockets.

% A memory module can be installed in only one way. Match the notch on the module with the tab
on the memory socket.
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5. Push the module down into the socket, ensuring that the module is fully inserted and
properly seated. Make sure the latches are in the closed position ©.

6. Repeat steps 4 and 5 for any additional modules that you want to install.

To reassemble the computer, reverse the removal procedure.
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6.6 Expansion Cards

The computer has two PCI expansion slots that can accommodate expansion cards up to
17.46 cm (6.875 inches) in length, one PCle x1 expansion slot, and one PCle x16 expansion slot.

6.6.1 Expansion Slot Cover Lock

. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
. Remove the access panel (Section 6.2, “Access Panel”).

. Lay the computer down on its side to make it easier to work on.

AW N =

. On the rear panel of the computer, remove the screw that secures the slot cover lock in
place @ then, slide the slot cover lock up and away from the slots to remove it from the

computer @.
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6.6.2 PCl/PCle Expansion Card

To remove an expansion card continue with step 1.
To install an expansion card in an existing empty slot go to step 9.
1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove the access panel (Section 6.2, “Access Panel”).
3. Lay the computer down on its side to make it easier to work on.
4. Remove the slot cover lock (Section 6.6.1, “Expansion Slot Cover Lock™)
If you are installing an expansion card for the first time go to step 9.
If you are replacing an existing expansion card go to step 5.
5. Disconnect any cables attached to the expansion card.

6. Hold the card at each end and carefully rock it back and forth until the connectors pull free
from the socket. Be sure not to scrape the card against other components.

7. Store the card in anti-static packaging.
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8. Install a new expansion card or an expansion slot cover to close the open slot.
To install a replacement expansion card go to step 10.

9. If you are installing an expansion card for the first time you must first remove the expansion
slot cover. Use a flatblade screwdriver to pry out the metal shield on the rear panel that
covers the expansion slot. Be sure you remove the appropriate shield for the expansion card
you are installing.

Removable Shield Expansion Card Type

Top shield PCle x16
Second shield PCl e x1
Third shield PCI
Bottom shield PCI

10. With the card aligned so the mounting bracket will fit firmly against the computer
backwall @, slide the expansion card into the expansion socket and press it firmly into
place @.

% When you install an expansion card, make sure you press firmly on the card so that the entire
connector seats properly in the expansion card socket.

11. Reinstall the slot cover lock and its retaining screw.
12. Replace the access panel.
13. Connect external cables to the installed card, if needed.

Reconfigure the computer, if necessary.
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6.7 Cable Management

Always follow good cable management practices when working inside the computer.

Keep cables away from major heat sources like the heatsink.

Do not jam cables on top of expansion cards or memory modules.Printed circuit cards like
these are not designed to take excessive pressure on them.

When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the
wires.

Some flat ribbon cables come prefolded. Never change the folds on these cables.
Do not bend any cable sharply. A sharp bend can break the internal wires.

Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

Never crease a SATA data cable.

Do not rely on components like the drive cage, power supply, or computer cover to push
cables down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the P1 connector on the system board,
always follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector @.

2. Grasp the cable end of the connector and pull it straight up @.

CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could damage the
cable and result in a failed power supply.
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6.7.1 Cable Connections

Cable To Cable Designator
Power Supply 1st SATA Hard drive P6
Power Supply System board, 24-pin P1
Power Supply CPU power, 4-pin P2
Power Supply 1st Optical drive P3
Power Supply 2nd Optical drive P4
Power Supply 2nd SATA Hard drive P5
Power Supply Diskette drive P7
Cable To PCA Designator
Diskette drive System board FDD1 (Black)

1st SATA Hard drive

System board

SATA O (Orange)

2nd SATA Hard drive

System board

SATA 1 (Orange)

ODD Data System board IDE1(Blue)

ODD Audio System board JCD1 (Black)
Heatsink fan System board CPU FAN 2 (Brown)
Secondary system fan System board SYSFAN1(White)
Front power on button System board JFPF1 (Black)

Front I/O USB System board JUSB1 (Black)
Speaker System board AUDIOT (White)
Front audio System board AUDT (Black)
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6.8 Drives

The computer supports up to four drives that may be installed in various configurations.

This Section describes the procedure for replacing or upgrading the storage drives. A Torx T-15
screwdriver is needed to remove and install the guide screws on a drive.

CAUTION: Make sure personal files on the hard drive are backed up to an external storage device
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary hard
drive, you will need to run the Restore Plus! CD to load the Compaq factory-installed files.

6.8.1 Drive Positions

Drive Positions

Item Description ltem Description

o Optical* drive (4] Internal hard drive (secondary)

(2] Optical* drive (5] Internal hard drive (primary)

(3] External” 3.5”

;An optical drive is a CD-ROM, CD-R/RW, DVD-ROM, DVD-R/RW, or CD-RW/DVD Combo
rive.

#Optional media card reader illustrated.
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6.8.2 5.25" Drive

. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

. Remove the access panel (Section 6.2, “Access Panel”).

. Remove the front bezel (Section 6.3, “Front Bezel”).

. Disconnect the power, data, and audio cables, as necessary, from the back of the drive.

. Remove the two retainer screws that secure the drive in the drive cage @.

AN L A W N~

. Slide the drive forward out of the drive cage, as shown in the illustration below @.

7. After the drive has been removed from the chassis, remove the two guide screws from the
right side of the drive. These screws should be transferred to the new drive.

To install a drive, reverse the removal procedure.

% If you are installing a 5.25" drive for the first time into bay 2 you must first remove the metal
shield that covers the bay by pressing in on the silver-colored tab on the left side of the chassis
then pulling the shield out from the front of the chassis. It is not necessary to remove the drive
from bay 1 when performing this operation.

% There are a total of eight extra guide/retainer screws on the front of the chassis behind the bezel.
Four have Unified Standard (U.S.) #6-32 standard threads and four have M3 metric threads. U.S.
screws are used for hard drives and have a silver finish. Metric screws are used for all other drives
and have a black finish. Be sure to install the appropriate guide screws into the drive.
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6.8.3 3.5" Drive

If you are installing a device for the first time in the external 3.5” drive bay you will need to use a
flat blade screwdriver to break out the metal shield.

The 3.5" external drive bay may be populated with a diskette drive or a media card reader. The
removal procedure is the same for both devices.

1. Turn off the computer properly through the operating system and turn off any external
devices.

2. Disconnect the power cord from the power outlet and the computer, and disconnect any
external devices.

3. Remove the access panel. (Section 6.2, “Access Panel”)
4. Remove the front bezel. (Section 6.3, “Front Bezel”)

5. If the device is a media card reader, disconnect the internal USB cable from the system
board. If the device is a diskette drive, disconnect the power and data cables from the back of
the drive.

6. Remove the retainer screws that secure the drive to the bay @ then slide the drive forward
and out of the bay @.

To install a drive, reverse the removal procedure. Be sure to install a guide screw on the front
right side of a new drive. The guide screw helps secure the drive in place.

Refer to the table on the following page for proper retainer and guide screw locations.
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Device Retainer Screws Guide Screws
Diskette Drive 2 (labeled “FDD” on chassis) 1 (front left side of
drive)
Media Card 2 (labeled “CR” on chassis) none
Reader

% If you are installing a drive in the external 3.5" drive bay for the first time, use a flatblade
screwdriver to pry out the metal shield covering the bay.

% There are a total of eight extra guide/retainer screws on the front of the chassis behind the bezel.
Four have Unified Standard (U.S.) #6-32 standard threads and four have M3 metric threads. U.S.
screws are used for hard drives and have a silver finish. Metric screws are used for all other drives
and have a black finish. Be sure to install the appropriate guide screws into the drive.
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6.8.4 Removing a 3.5” Hard Drive

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove the access panel (Section 6.2, “Access Panel”).

3. Remove the front bezel (Section 6.3, “Front Bezel”).

4. Disconnect the power, and data cables from the back of the drive.

5. Remove the four retaining screws that secure the drive in the drive cage @.

6. Slide the drive out of the rear of the drive bay @.

To replace the hard drive, reverse the removal procedure. No guide screws are required for drives
installed in the hard drive bays (bays 4 and 5).

% If you replaced the primary hard drive, the Restore Plus! CD may be used to restore the operating
system, software drivers, and/or any software applications that were preinstalled on the
computer. Follow the instructions in the guide included with the CD. When the restore process
has been completed, reinstall any personal files that were backed up before replacing the hard
drive.
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6.9 Front 1/0 Panel Housing Assembly

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table
to make it easier to work on (Section 6.1, “Preparation for Disassembly”).

3. Disconnect two attaching cables from the system board: the power switch/LED cable, and
the front USB cable.

4. Free the two cables from the cable tie that is attached to the chassis.

5. Remove the screw @ that secures the housing to the chassis and then rotate the housing away
from the chassis and pull the assembly out of the chassis @.

To install the housing assembly, reverse the removal procedures.
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6.9.1 Power Switch Assembly

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table
to make it easier to work on (Section 6.2, “Access Panel”).

3. Disconnect the braided Power/LED cables from the system board.
4. Free the braided cables from the cable tie that is attached to the chassis.

5. Squeeze the top of the switch holder @. rotate the switch, and remove it from the chassis.

To install the power switch assembly, reverse the removal procedures.
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6.10 Speaker

. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
. Remove the access panel (Section 6.2, “Access Panel”).

. Remove the front bezel (Section 6.3, “Front Bezel”).

. Disconnect the speaker cable from the system board.

. Free the cable from the cable tie that is attached to the chassis.
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. Remove the screw that secures the speaker to the inside of the chassis @ then, remove the
speaker @ by sliding it out of the retaining clips

To install the speaker, reverse the removal procedure.

When installing the speaker, make sure the speaker wires point towards the speaker retaining
SCrew.
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6.11 System Fan

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove the access panel (Section 6.2, “Access Panel”).
3. Disconnect the cable that connects the system fan to the system board.

4. Remove the screws that secure the fan to the chassis and remove the fan.

To install the fan, reverse the removal procedures.

% When installing the fan, make sure the wires leading from the fan are located near the P2 4-pin
power connector on the system board.
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6.12 Heatsink

. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
. Remove the access panel (Section 6.2, “Access Panel”).

. Lay the computer down on its side to make it easier to work on.

. Disconnect the heatsink control cable from the system board.

. Loosen the four captive screws that secure the heatsink to the system board.
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. Lift the heatsink from atop the processor and set it on its side to keep from contaminating the
work area with thermal grease.

When reinstalling an existing heatsink, make sure that its bottom has been cleaned with an
alcohol wipe and fresh thermal grease has been applied to the top of the processor. New heatsinks
come from the factory with fresh thermal grease already applied.

Position the heatsink so that fan wiring is closest to the power supply. Check to ensure that the
heatsink mounting lugs do not rest on any electrical components before tightening the retaining
SCrews.

CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to
evenly seat the heatsink to the processor. This is especially important as the pins on the socket are very
fragile and any damage to them may require replacing the system board.

Service Reference Guide, dx2200 MT 415606-001 6-21



Removal and Replacement Procedures— Microtower (MT) Chassis

6.13 Processor

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove the access panel cover (Section 6.2, “Access Panel”).

3. Disconnect the heatsink control cable from the system board and remove the
heatsink.(Section 6.12, “Heatsink™)

4. Rotate the processor locking lever to its full open position @.
5. Raise and rotate the microprocessor retainer to its full open position @.

6. Carefully lift the processor from the socket ©.

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and handling
them could cause irreparable damage. Once pins are damaged it may be necessary to replace the
system board.

CAUTION: The heatsink must be installed within 24 hours of installing the processor to prevent damage
to the processor’s solder connections.

To install a new processor:
1. Place the processor in its socket and close the retainer.
2. Secure the locking lever.

If reusing the existing heatsink, go to step 3.

If using a new heatsink, go to step 6.

3. If reusing the existing heatsink, clean the bottom of the heatsink with the alcohol pad
provided in the spares Kkit.

4. Apply the thermal grease provided in the spares kit to the top of the processor and install the
heatsink atop the processor.
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5. Goto step 7.

6. If using a new heatsink, remove the protective covering from the bottom of the heatsink and
place it in position atop the processor.

7. Secure the heatsink to the system board and system board tray with the 4 captive screws and
attach the heatsink control cable to the system board.

CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to
evenly seat the heatsink on the processor. This is especially important as the pins on the socket are very
fragile and any damage to them may require replacing the system board.

% After installing a new processor onto the system board, always update the system ROM to ensure
that the latest version of the BIOS is being used on the computer. The latest system ROM BIOS
can be found on the Web at: http:\\n18000.www1.hp.com/support/files.
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6.14 System Board

. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
. Remove the access panel (Section 6.2, “Access Panel”).

. Remove the front bezel (Section 6.3, “Front Bezel”).

. Disconnect the power, and data cables from the back of all installed drives.

. Disconnect all cables from the system board.

. Remove the heatsink from the system board (Section 6.12, “Heatsink™).

. Remove the 6 screws that secure the system board to the chassis @.
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. Slide the system board towards the front of the chassis @ then remove it ©.

% The system board in the computer may look slightly different from the one shown here.

To install the system board, reverse the removal procedure.

% After installing a new system board, always update the system ROM to ensure that the latest
version of the BIOS is being used on the computer. The latest system ROM BIOS can be found
on the Web at: http:\\h18000.www 1.hp.com/support/files.
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6.15

> 7

Battery

The battery that comes with your computer provides power to the real-time clock and has a
lifetime of about three years. When replacing the battery, use a battery equivalent to the battery
originally installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall
socket. The lithium battery is only used when the computer is NOT connected to AC power.

WARNING: This computer contains an internal lithium manganese dioxide battery. There is a risk of fire and
burns if the battery is not handled properly. To reduce the risk of personal injury:
Bl Do not attempt to recharge the battery.

Do not expose to temperatures higher than 140°F (60°C)

|

B Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or
water.

|

Replace the battery only with the HP/Compagq spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Troubleshooting
Guide for information on backing up the CMOS settings.

Batteries, battery packs, and accumulators should not be disposed of together with the general
household waste. In order to forward them to recycling or proper disposal, please use the public
collection system or return them to HP/Compag, their authorized partners, or their agents.

CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the right access panel (Section 6.2, “Access Panel”).

It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.
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6.15.1 Type 1 Battery Holder

1. Lift the battery out of its holder.

. Slide the replacement battery into position, positive side up.
. The battery holder automatically secures the battery in the proper position.
. Replace the computer access panel.

. Plug in the computer and turn on power to the computer.

AN A W N

. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to the Computer Setup (F10) Utility Guide.
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6.15.2 Type 2 Battery Holder

1. To release the battery from its holder, squeeze the metal clamp that extends above one edge
of the battery. When the battery pops up, lift it out @.

2. To insert the new battery, slide one edge of the replacement battery under the holder’s lip
with the positive side up @. Push the other edge down until the clamp snaps over the other
edge of the battery.

3. Replace the computer access panel.
4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to the Computer Setup (F10) Utility Guide.
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6.15.3 Type 3 Battery Holder

1. Pull back on the clip @ that holds the battery in place, then remove the battery @.

2. Insert the new battery and position the clip back in place.

3. Replace the computer access panel.
4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to the Computer Setup (F10) Utility Guide.
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6.16 Power Supply

WARNING: Voltage is always present on the system board when the computer is plugged into an
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord should
be disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel (Section 6.2, “Access Panel”).

3. Disconnect all power cables from the mass storage devices and from the system board.
4. Remove the 4 screws @ that secure the power supply to the chassis.

5. Slide the power supply toward the front of the computer @, then lift it out of the computer.
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To install the power supply, reverse the removal procedure.
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Connector Pin Assignments

This appendix contains the pin assignments for many computer and workstation connectors.
Some of these connectors may not be used on the product being serviced.

Enhanced Keyboard
Connector and lcon Pin Signal

Data
Unused
Ground

+5 VDC
Clock
Unused

a0
oo
oo

i

Ok WON —

Mouse

Connector and lcon Pin Signal
Bpa
(B]u)

Ethernet RJ-45
Connector and Icon Pin Signal

Data
Unused
Ground

+5 VDC
Clock
Unused

A WON —

1 (+) Transmit Data
2 () Transmit Data
’:I B 3 (+) Receive Data
ﬁ 4 Unused
5 Unused
6 () Receive Data
7 Unused
8 Unused
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Connector Pin Assignments

Parallel Interface

Connector and Icon

\@@@@@@@O@@O/ m

(olojeleololoJololololo)C) [—\¢0
Pin Signal Pin Signal Pin Signal
1 Strobe 7 Data Bit 5 13 Select
2 Data Bit O 8 Data Bit 6 14 Auto Linefeed
3 Data Bit 1 9 Data Bit 7 15 Error
4 Data Bit 2 10 Acknowledge 16 Initialize Printer
5 Data Bit 3 11 Busy 17 Select IN
6 Data Bit 4 12 Paper End 1825 Signal Ground

Serial Interface, Powered and Non-Powered
Connector and lcon Pin Signal

1 Carrier Detect (12V if powered)
2 Receive Data
0Jojofojo 3 Transmit Data
0J0)
4 Data Terminal Ready
5 Signal Ground
6 Data Set Ready
7 Request to Send
8 Clear to Send
9 Ring Indicator (5V if powered)
USB
Connector and Icon Pin Signal
1 +5 VDC
2 - Data
4 Ground
Microphone
Connector and Icon (1/8" miniphone) Pin Signal

1 (Tip) Audio

ﬁéﬂ:ﬂ: @ 2 (Ring) Power

3 (Shield)  Ground
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Connector Pin Assignments

Headphone
Connector and Icon (1/8" miniphone) Pin Signal
1 (Tip) Audio_Left
123
@: @ ) 2 (Ring) Audio_Right
3 (Shield)  Ground
Line-In Audio
Connector and Icon (1/8" miniphone) Pin Signal
1 (Tip) Audio_In_Left
123 _ . )
Ll $<: 2 Ring)  Audio_In_Right
3 (Shield)  Ground
Line-Out Audio
Connector and Icon (1/8" miniphone) Pin Signal

123 (ﬁ:>

1 (Tip)
2 (Ring)

3 (Shield)

Audio_Out_Left
Audio_Out_Right
Ground

Monitor

Connector and Icon

00REO
glelolo)

OO
Pin  Signal Pin  Signal Pin  Signal
1 Red Analog 6 Ground 11 Not used
2 Green Analog 7 Ground 12 DDC Serial Data
3 Blue Analog 8 Ground 13 Horizontal Sync
4 Not used 9 +5V DC (fused) 14 Vertical Sync
5 Ground 10 Ground 15 DDC Serial Clock
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Connector Pin Assignments

ATA/ATAPI (IDE) Standard Drive Cable

39

Connector

1

OoooooooDoao OoooooDooo

40

2

Pin Signal Pin Signal Pin Signal
1 Reset 15 DD1 29 DMAK
2 Ground 16 DD14 30 Ground
3 DD7 17 DDO 31 INTRQ
4 DD8 18 DD15 32 IOCS16
5 DD6 19 Ground 33 DA1
6 DD9 20 (Key) 34 PDIAG (cable detect)
7 DD5 21 DMARQ 35 DAO
8 DD10 22 Ground 36 DA2
9 DD4 23 DIOW 37 CSTFX
10 DD11 24 Ground 38 CS3FX
11 DD3 25 DIOR 39 DASP
12 DD12 26 Ground 40 Ground
13 DD2 27 IORDY
14 DD13 28 CSEL
24-Pin Power
Connector
24 — 13C
(=)= ][=](=)Ce)[=][=]Ca) () [=][] )
[=](e) () =] [=]Ca) (e ) [=][=](a) (&[]
12 1
Pin Signal Pin Signal Pin Signal Pin Signal
1 +3.3V 7 Aux GND 13 +33V 19 GND
2 +3.3V 8 PWROK 14 12V 20 NI
3 GND 9 +5 Vaux 15 GND 21 +5V
4 +5V 10 +12V 16 PSON 22 45V
5 GND 11 +12V 17 GND 23 +5V
6 +5V 12 433V 18  GND/(R/S) 24  GND
*Open for d300 series computers; -5V for all others
4-Pin Power (for CPU)
Connector and lcon Pin Signal
. s 1 GND
—
2 GND
0:10(0)=0)
=] 3 +12V
2 1 4 +12V
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Power Cord Set Requirements

The voltage select switch feature on the computer permits it to operate from any line voltage
between 100-120 or 220-240 volts AC.

The power cord set received with the computer meets the requirements for use in the country
where you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you
use the computer. For more information on power cord set requirements, contact your authorized
HP dealer, reseller, or service provider.

General Requirements

The requirements listed below are applicable to all countries:

1. The length of the power cord set must be at least 1.8 m (6.00 feet) and a maximum of 3.0 m
(9.75 feet.)

2. All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country where the power cord set will be used.

3. The power cord set must have a minimum current capacity of 10A and a nominal voltage
rating of 125 or 250 volts AC, as required by each country’s power system.

4. The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector, for mating with appliance inlet on the Switch Box.
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Power Cord Set Requirements

Country-Specific Requirements

Additional requirements specific to a country are shown in parentheses and explained below.

Accrediting Accrediting

Country Agency Country Agency
Australia (1) EANSW ltaly (1) IMQ
Austria (1) OVE Japan (3) METI
Belgium (1) CEBC Norway (1) NEMKO
Canada (2) CSA Sweden (1) SEMKO
Denmark (1) DEMKO Switzerland (1) SEV
Finland (1) SETI United Kingdom (1) BSI
France (1) UTE United States (2) uL
Germany (1) VDE

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 1.0 mm? conductor size.
Power cord set fittings (appliance coupler and wall plug) must bear the certification mark of
the agency responsible for evaluation in the country where it will be used.

2. The flexible cord must be Type SIT or equivalent, No. 18 AWG, 3-conductor. The wall plug
must be a two-pole grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P
(15A 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a "T" mark and registration
number in accordance with the Japanese Dentori Law. Flexible cord must be Type VCT or

VCTF, 3-conductor, 1.0 mm? conductor size. Wall plug must be a two-pole grounding type
with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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POST Error Messages

An error message results if the Power-On Self-Test (POST) encounters a problem. This test runs
when the system is turned on, checking assemblies within the computer and reporting any errors

found.

Not all computers use all of the codes listed.

Recommended Actions are to be taken in incremental steps. Perform one step at a time and

continue only if the action does not cure the problem.

POST Error Messages

Screen Message

Probable Cause

Recommended Action

Gate 20 Error

BIOS cannot access
memory over 1MB.

Reseat memory modules.
Replace memory modules.

Parity Error

Fatal memory parity
error. System halts after
displaying this message.

Reseat memory modules.

Replace memory modules.

Boot Failure...

BIOS could not boot from
the device. This message
is usually followed by
information about the
specific device.

Reseat the device data and power
cables.

Replace the device data cable.
Replace the device.

Replace the system board.

Invalid Boot Diskette

Diskette in drive A: not
bootable.

Replace the diskette.

Drive Not Ready

BIOS could not configure
drive A: during POST.

Reseat the device data and power
cables.

Replace the device data cable.
Replace the device.
Replace the system board.

Drive A: Error

BIOS could not configure
drive A: during POST.

Reseat the device data and power
cables.

Replace the device data cable.
Replace the device.
Replace the system board.

Insert BOQOT Diskette In
A:

BIOS could not find a
bootable diskette in drive
A:.

Replace the diskette.

Service Reference Guide, dx2200 MT
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POST Error Messages

POST Error Messages

Screen Message

Probable Cause

Recommended Action

Primary Master/Slave
Hard Disk Error

Primary Master/Slave
hard drive could not be
initialized by the BIOS.

Reseat the device data and power
cables.

Replace the device data cable.
Replace the device.

Replace the system board.

Secondary Master/
Slave Hard Disk Error

Secondary Master/Slave
hard drive could not be

initialized by the BIOS.

Reseat the device data and power
cables.

Replace the device data cable.
Replace the device.
Replace the system board.

Primary Master/Slave
Drive — ATAPI
Incompatible

Device configured as a
Primary/ Master/Slave
failed an ATAPI
compatibility fest.

Replace the device.

Replace the system board.

Secondary Master/
Slave Drive — ATAPI
Incompatible

Device configured as a
Secondary/ Master/
Slave failed an ATAPI
compatibility fest.

Replace the device.

Replace the system board.

S.M.A.R.T. Capable but
Command Failed.

S.M.A.R.T. Command
Failed

BIOS unable to send a
S.M.AR.T. message to
the device.

Backup the data on the hard drive.
Replace the hard drive.

S.M.A.R.T. Status Bad,

Backup and replace.

S.M.A.R.T. Capable
and Status Bad.

S.M.AR.T. capable hard
drive detects an imminent
failure.

Backup the data on the hard drive, then
replace the hard drive.

DMA-T Error
DMA-2 Error

Error when initializing
secondary DMA
controller.

Reconnect the cables on the peripheral
device.

Replace the data cable.
Replace the device.

Replace the system board.

DMA Controller Error

POST error while trying to
initialize the DMA

controller.

Reconnect the cables on the peripheral
device.

Replace the data cable.
Replace the device.
Replace the system board.

Checking
NVRAM...Update
Failed

BIOS could not write to
the NVRAM block.

Change system board jumper on JP2 to
pins 2-3 (Unlock), then flash the system
BIOS. Reset the jumper to pins 1-2 (Lock).

Replace the system board.

c-2
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POST Error Messages

POST Error Messages

Screen Message

Probable Cause

Recommended Action

Microcode Error

BIOS could not find or
load the CPU microcode
update to the CPU.

Ensure the system board BIOS supports
the processor.

Change system board jumper on JP2 to
pins 2-3 (Unlock), then flash the system
BIOS. Reset the jumper to pins 1-2 (Lock).

NVRAM Checksum
Bad, NVRAM Cleared

Error detected while

validating NVRAM data.

Restart the computer, use the F10 Key to
access Computer Setup. Select Load
Default Settings > Save and Exit.

NVRAM Ignored

NVRAM data used to
store plug and play data
was not used for system
configuration in POST.

Restart the computer, use the F10 Key to
access Computer Setup. Select Load
Default Settings > Save and Exit.

Change system board jumper on JP2 to
pins 2-3 (Unlock), then flash the system
BIOS. Reset the jumper to pins 1-2 (Lock).

Replace the system board.

NVRAM Bad NVRAM data used to Restart the computer, use the F10 Key to
store plug and play data  access Computer Setup. Select Load
was not used for system Default Settings > Save and Exit.
configuration in POST. Change system board jumper on JP2 to

pins 2-3 (Unlock), then flash the system
BIOS. Reset the jumper to pins 1-2 (Lock).
Replace the system board.

Timer Error Error found while Replace the system board.

programming the count
register of channel 2 of

the 8254 timer.

Interrupt Controller-1
Error

BIOS POST could not
initialize the Master/
Slave Interrupt controller.

Replace the system board.

CMOS Date/Time Not
Set

CMOS Date and/or Time

is invalid.

Set the date and time under Control
Panel or in F10 Setup depending on
the operating system.

If problem persists, replace the RTC
battery.

CMOS Battery Failed

CMOS battery failed.

Replace the RTC battery.

CMQOS Battery Low

CMOS battery weak.

Replace the RTC battery.

CMOS Settings Wrong

Invalid CMOS settings.

Restart the computer, use the F10 Key to
access Computer Setup. Select Load
Default Settings > Save and Exit.

CMOQOS Checksum Bad

CMOS contents failed the
Checksum check.

Restart the computer, use the F10 Key to
access Computer Setup. Select Load
Default Settings > Save and Exit.
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POST Error Messages

POST Error Messages

Screen Message

Probable Cause

Recommended Action

CMOS Checksum Error.
Defaults Loaded

CMOS corrupt or bad
RTC battery.

Press F1 to save defaults.
Replace RTC battery.

Download the current ROM BIOS from
the HP Web and reflash the ROM BIOS.

ROM BIOS Checksum
Error - system halted

ROM BIOS may be
corrupted.

Download the most current ROM BIOS
from the Web and reflash the system
ROM.

Keyboard/Interface
Error

Keyboard controller
failure.

Reconnect keyboard with computer
turned off.

Check connector for bent or missing
pins.

Ensure that none of the keys are
depressed.

Replace keyboard.

Replace system board.

Keyboard Error or No
Keyboard Present

Keyboard not present or
system not responding
when keyboard controller
is initialized.

Reconnect keyboard with computer
turned off.

Check connector for bent or missing
pins.

Ensure that none of the keys are
depressed.

Replace keyboard.

Replace system board.

Hard Disk Install Failure

Cannot find or initialize

the hard drive.

Check Computer Setup (F10 Setup) for
presence of hard drive.

Check drive cable connections.
Replace hard drive.

Memory Test Failure

If POST detects an error
during memory testing,
additional information
appears about the type
and location of the
memory error.

Run Computer Setup (F10 Setup) or
Windows utilities.

Ensure memory modules are installed
correctly.

Verify proper memory module type.

Remove and replace memory modules
one at a time to isolate faulty module.

Replace the faulty memory module.

If error persists after replacing memory
module, replace the system board.

415606-001
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POST Error Messages

POST Error Messages

Screen Message Probable Cause Recommended Action
Non-System Disk or BIOS unable to find a Verify that the device booting from is
Disk Error suitable boot device. bootable. Replace as needed.
Warning: CPU Fan Has  CPU fan weak or not Ensure that the computer air vents are
Failed. For Thermal active. not blocked and the chassis cooling fan

Protection, System will
be shut down. A 3
second long beep will

be heard before the

system will shut down.

is running.

Open hood, press power button, and
see if the chassis fan spins. If the fan is
not spinning, make sure the fan's cable
is plugged onto the system board
header. Ensure the fan is fully/properly
installed.

If fan is plugged in but is not spinning
then, replace chassis fan.

Replace the chassis fan.

Warning: Processor Fan  Processor fan weak or not
Has Failed. For Thermal  active.

Protection, System will

be shut down. A 3

second long beep will

be heard before the

system will shut down.

Ensure that the computer air vents are
not blocked and the processor cooling
fan is running.

Open hood, press power button, and
see if the processor fan spins. If the
processor fan is not spinning, make sure
the fan's cable is plugged onto the
system board header. Ensure the fan is
fully/properly seated or installed.

If fan is plugged in and seated properly,
but is not spinning, then replace
processor fan/heatsink assembly.

Contact an authorized reseller or service
provider.

POST Diagnostic Front Panel LEDs and Audible Codes

This section covers the front panel LED codes as well as the audible codes that may occur before
or during POST that do not necessarily have an error code or text message associated with them.

% If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of the
computer and refer to the following table to determine the front panel LED codes.

% Recommended actions in the following table are listed in the order in which they should be

performed.
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POST Error Messages

POST Diagnostic Front Panel LEDs and Audible Codes

Activity Beeps Possible Cause Recommended Action
Green Power LED ~ None Computer on. None
On.
Green Power LED ~ None Computer in None required. Press any key or move the
flashes every two Suspend to RAM  mouse to wake the computer.
seconds. mode (some
models only) or
normal Suspend
mode.
Power LED flashes ~ None Processor thermal  Ensure that the computer air vents are not
every 4 seconds. protection blocked and the processor cooling fan is
This continues until activated: running.
the issue has been A fan may be Open hood, press power button, and see
resolved. blocked or not if the processor fan spins. If the processor
turning. fan is not spinning, make sure the fan's
OR cable is plugged onto the system board
The heatsinkfan header.
assembly is not If fan is plugged in but is not spinning,
properly attached  then replace processor fan.
to the processor. ~ Reseat processor heatsink and verity that
the fan assembly is properly attached.
Contact an authorized reseller or service
provider.
Power LED flashes ~ None Pre-video memory  Reseat DIMMs. Power on the system.

five times, once
every second,
followed by a two
second pause.
LEDs continue until
problem is solved.

error.

Replace DIMMs one at a time to isolate
the faulty module.

Replace third-party memory with HP
memory.

Replace the system board.

415606-001
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POST Error Messages

POST Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps Possible Cause Recommended Action

Power LED flashes ~ None Pre-video For systems with a graphics card:
six times, once graphics error. Reseat the graphics card. Power on the
every second, system.
followed by a two R ,

eplace the graphics card.
second pause.

LEDs continue until Replace the system board.
problem is solved. For systems with integrated graphics,

replace the system board.

Power LED flashes  None Invalid ROM Reflash the ROM with the latest BIOS
eight times, once based on bad image. See the “ROM Flash” section of the
every second, checksum. Desktop Management Guide on the
followed by a two Documentation and Diagnostics CD.
second pause. Replace the system board.

LEDs continue until
problem is solved.

System does not None System unable to  Press and hold the power button for less

power on and
LEDs are not
flashing.

power on.

than 4 seconds. If the hard drive LED turns
green, then:

Check that the voltage selector, located on
the rear of the power supply, is set to the
appropriate voltage. Proper voltage
setting depends on your region.

Remove the expansion cards one at a time
until the LED light on the system board
turns on.

Replace the system board.
OR
Press and hold the power button for less

than 4 seconds. If the hard drive LED does

not turn on green then:
Check that the unit is plugged into a
working AC outlet.

Open hood and check that the power
button harness is properly connected to
the system board.

Check that both power supply cables are
properly connected to the system board.

Check to see if the LED light on the system
board is turned on. If it is turned on, then
replace the power button harness.

If the LED light on the system board is not
turned on, then replace the power supply.

Replace the system board.
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Memory

Computers equipped with Intel-based processors come with double data rate synchronous
dynamic random access memory (DDR2-SDRAM) dual inline memory modules (DIMMs).

The memory sockets on the system board can be populated with up to two industry-standard
DIMMs. These memory module slots are populated with at least one pre installed memory
module. To achieve the maximum memory support, you can populate the system board with up
to 2GB of memory configured in a high-performing dual channel mode.

For proper system operation, the computer supports DDR2-SDRAM DIMMs. The DIMMs must
be industry-standard 240-pin, unbuffered PC2 5300 667 MHz- compliant, 1.9 volt DDR2-
SDRAM DIMMs. The DDR2-SDRAM DIMMs must also:

B support CAS latency 4 (CL =4) for PC2 5300 667 MHz

B contain the mandatory JEDEC SPD information

In addition, the computer supports:

B 256Mbit, 512Mbit, and 1 Gbit non-ECC memory technologies
B single-sided and double-sided DIMMS

B DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM
are not supported

B The maximum operational speed is determined by the slowest DIMM in the system.

% The system will not start if you install unsupported DIMMs.
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Troubleshooting Without Diagnostics

Preliminary Checklist

This section describes some simple, preliminary tests and guidelines for troubleshooting the
computer without using the diagnostics.

Are the computer and monitor connected to a working electrical outlet?

Is the voltage select switch is set to the appropriate voltage for your region (115V or 230V)?
Is the computer turned on?

Is the green power light illuminated?

Is the monitor turned on?

Is the green monitor light illuminated?

Turn up the monitor brightness and contrast controls if the monitor is dim.

If the system has multiple video sources (embedded, PCI, or AGP adapters) installed
(embedded video on select models only) and a single monitor, the monitor must be plugged
into the monitor connector on the source selected as the primary VGA adapter. During boot,
the other monitor connectors are disabled and if the monitor is connected into these ports, the
monitor will not function. You can select which source will be the default VGA source in
Computer (F10) Setup.

Press and hold any key. If the system beeps, then the keyboard is operating correctly.
Check all cables for loose or incorrect connections.

Reconfigure the computer after installing a non—Plug and Play expansion board or other
option, such as a diskette drive.

Are all of the necessary device drivers installed?

Have all printer drivers been installed for each application?

Remove all diskettes from the diskette drives before you turn on the system.
Are all switches set correctly?

Is the NIC Remote Wakeup cable (featured on some models) connected between the NIC and
the riser/system board?
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Troubleshooting Without Diagnostics

Solving Minor Problems

Solving Minor Problems

Problem

Cause

Possible Solution

Computer appears
locked up and will not
turn off when the power
button is pressed.

Software control of the
power switch is not
functional.

1. Press and hold the power button
for at least four seconds until the
computer turns off.

2. Disconnect electrical plug from
outlet.

Computer will not
respond to USB
keyboard or mouse.

Computer is in
standby mode.

Press the power button to resume from
standby mode.

A CAUTION: When attempting to resume from standby mode, do not hold down the power
button for more than four seconds. Otherwise, the computer will shut down and you will lose

your data.

Computer date and

time display is incorrect.

RTC (realtime clock)
battery may need to be
replaced.

1. Reset the date and time under
Control Panel.

2. Replace the RTC battery.

Computer appears to
pause periodically.

Network driver is loaded
and no network

connection is established.

Establish a network connection, or
use Computer Setup or Microsoft
Windows Device Manager to disable
the network controller.

Cursor will not move
using the arrow keys on

the keypad.

The Num Lock key

may be on.

Press the Num Lock key. The Num

Lock key can be disabled (or
enabled) in Computer Setup.

Poor performance is
experienced.

Processor is hot.

1. Ensure airflow to the computer is
not blocked. Leave a 10.2-cm
(4-inch) clearance on all vented
sides of the computer and
monitor to permit required
airflow.

2. Ensure the fans are connected
and working properly (some fans
only operate when needed).

3. Ensure the processor heatsink is
installed properly.

Hard drive is full.

Transfer data from the hard drive to
create more space on the hard drive.

415606-001
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Troubleshooting Without Diagnostics

Solving Minor Problems (Continued)

Problem

Cause

Possible Solution

Computer powered off
automatically and the
Power LED flashes every
four seconds.

Processor thermal
protection activated:

A fan may be blocked or
not turning.

OR

The heatsink is not
properly attached to the
processor.

1. Ensure computer air vents are not
blocked and the cooling fan is
running.

2. Open hood, press power button,
and see if the processor fan
spins. If not spinning, make sure
the fan's cable is plugged onto
the system board header. Ensure
the fan is fully/properly seated or
installed.

3. Replace the processor fan.

4. Reseat processor heatsink and
verify that the fan assembly is
properly attached.

System does not power
on and the LEDs on the
front of the computer
are not flashing.

System unable to power
on.

Press and hold the power button for
less than 4 seconds. If the hard drive
LED turns green, then:

1. Check that the voltage selector is
set fo the appropriate voltage.

2. Remove the expansion cards one
at a time until the 3.3 V_aux light
on the system board turns on.

3. Replace the system board.
OR

Press and hold the power button for
less than 4 seconds. If the hard drive
LED does not turn on green then:

1. Check that the unit is plugged
info a working AC outlet.

2. Open hood and check that the
power button harness is properly
connected to the system board.

3. Check that both power supply
cables are properly connected to
the system board.

4. If the 3.3 V_aux light on the
system board is on, then replace
the power button harness.

5. If the 3.3 V_aux light on the
system board is off, then replace
the power supply.

6. Replace the system board.
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Troubleshooting Without Diagnostics

Solving Power Supply Problems

Solving Power Supply Problems

Problem Cause Solution

Power supply shuts down

intermittently.

Voltage selector switch
on rear of computer
chassis not switched to
correct line voltage.

Select the proper AC voltage.

Power supply fault.

Replace the power supply.

Computer powered off
automatically and the
Power LED flashes every
four seconds.

Processor thermall
protection activated:

A fan may be blocked

or not turning.
OR
The heatsink/fan

assembly is not properly

1. Ensure that the computer air

vents are not blocked and the
cooling fan is running.

. Open hood, press the power

button, and see if the processor
fan spins. If the processor fan is
not spinning, make sure the

fan's cable is plugged onto the
system board header. Ensure
the fan is fully/properly seated
or installed.

attached to the
processor.

3. Replace the processor fan.

4. Reseat processor heatsink and
verify that the fan assembly is
properly attached.
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Troubleshooting Without Diagnostics

Solving Diskette Problems

Solving Diskette Problems

Problem

Cause

Solution

Diskette drive light stays on.

Diskette is damaged.

In Microsoft Windows XP, right-click
Start, click Explore, and select a
drive. Select File > Properties >
Tools. Under Error-checking,
click Check Now.

Diskette is incorrectly
inserted.

Remove diskette and reinsert.

Drive button is not
pushed in.

Push in drive button.

Files on diskette are
damaged.

Check the program diskettes.

Drive cable is not
properly connected.

Reconnect power cable. Ensure that
all four pins are connected.

Drive not found.

Cable is loose.

Reseat diskette drive data and
power cables.

Removable drive is not
seated properly.

Reseat the drive.

You attempted to hot
plug a removable
hard drive that has
Drivelock security
enabled. (This feature
supported on select
models only.)

Shut down the computer. Insert the
drive info the MultiBay, if it is not
already inserted. Turn on the
computer.

Diskette drive cannot write

to a diskette.

Diskette is not
formatted.

Format the diskette.

Diskette is write-
protected.

Use another diskette or remove the
write protection.

Writing fo the wrong
drive.

Check the drive letter in the path
statement.

Not enough space is
left on the diskette.

Use another diskette.

Diskette write control is
enabled.

Use Computer Setup to check the
storage security feature disabled
settings.

Diskette is damaged.

Replace the damaged disk.

Cannot format diskette.

Invalid media reported.

When formatting a disk in MS-DOS,
you may need to specify diskette
capacity. For example, to format a
1.44-MB diskette, type the following
command at the MS-DOS prompt:

FORMAT A: /F:1440
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Troubleshooting Without Diagnostics

Solving Diskette Problems (Continued)

Problem

Cause

Solution

A problem has occurred
with a disk transaction.

The directory structure is
bad, or there is a
problem with a file.

In Windows XP, right-click Start,
click Explore, and select a drive.
Select File > Properties >
Tools. Under Error-checking,
click Check Now.

Diskette drive cannot read

a diskette.

Diskette is not
formatted.

Format the diskette.

You are using the wrong
diskette type for the
drive type.

Check the type of drive that you
are using and use the correct
diskette type.

You are reading the
wrong drive.

Check the drive letter in the path
statement.

Diskette is damaged.

Replace the diskette with a new one.

“Invalid system disk”
message is displayed.

A diskette that does not
contain the system files
needed to start the
computer has been
inserted in the drive.

When drive activity stops, remove
the diskette and press the
Spacebar. The computer should
start up.

Diskette error has
occurred.

Restart the computer by pressing the
power button.

Cannot Boot to Diskette.

Diskette is not bootable.

Replace with a bootable diskette.

Diskette boot has been
disabled in Computer
Setup.

Run Computer Setup and enable
diskette boot in Storage > Boot
Order.

Removable media boot
has been disabled in
Computer Setup.

Run Computer Setup and enable
Removable Media Boot in
Storage > Storage Options.

Diskette MBR validation
is enabled.

Run Computer Setup and disable
Diskette MBR Validation in
Storage > Storage Options.

Solving Hard Drive Problems

Solving Hard Drive Problems

Problem

Cause

Solution

Hard drive error occurs.

Hard disk has bad

sectors or has failed.

Use a utility to locate and block
usage of bad sectors. If necessary,
reformat the hard disk.

Disk transaction problem.

Either the directory
structure is bad or there
is a problem with a file.

In Windows XP, right-click Start,
click Explore, and select a drive.
Select File > Properties > Tools.
Under Error-checking, click
Check Now.
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Solving Hard Drive Problems (Continued)

Problem

Cause

Solution

Drive not found (identified).

Loose cable.

Check cable connections.

The system may not
have automatically
recognized a newly
installed device.

1. Run Computer Setup.

2. If the system still does not
recognize the new device,
check to see if the device is
listed within Computer Setup. If
it is listed, the probable cause is
a driver problem. If it is not
listed, the probable cause is a
hardware problem.

3. If this is a newly installed drive,
enter Setup and try adding a
POST delay under Advanced
> Power-On.

Drive’s IDE (ATA)
controller is disabled in
Computer Setup.

Run Computer Setup and enable the
Primary and Secondary IDE (ATA)
controllers in Storage > Storage
Options.

Drive responds slowly
immediately after
power-up.

Run Computer Setup and increase
the POST Delay in Advanced >
Power-On Options.

Nonsystem disk/NTLDR
missing message.

System is trying to start
from a non bootable
diskette.

Remove the diskette from the diskette
drive.

System is trying to start
from a damaged hard
drive.

1. Insert a bootable diskette into
the diskette drive and restart the
computer.

2. If the hard drive is still
inaccessible and MBR Security
is enabled, try restoring the
previously saved MBR image by
entering Setup and selecting
Security > Restore Master
Boot Record.

System files missing or
not properly installed.

1. Insert a bootable system diskette
and restart.

2. Verity hard drive is partitioned
and formatted.

3. Install system files for the
appropriate operating system if
necessary.

Hard drive boot
disabled in Computer
Setup.

Run Computer Setup and enable the
hard drive entry in the Storage >
Boot Order list.
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Solving Hard Drive Problems (Continued)

Problem Cause Solution
Computer will not start. Hard drive is damaged.  Observe the beeps and LED lights
on the front of the computer. See
Appendix C, “POST Error
Messages”.
Computer seems to be Program in use has 1. Attempt the normal Windows
locked up. stopped responding to “Shut Down” procedure.
commands. 2. Press the power button for
four or more seconds to turn off
the power.
3. Restart the computer using the
power button.
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Solving Display Problems

Solving Display Problems

Problem

Cause

Solution

Blank screen (no video).

The cable connections
are not correct.

Check the cable connections from
the monitor to the computer and to
the electrical outlet.

Screen blanking utility
installed or energy

saver features enabled.

Press any key or click the mouse
button and, if set, type your
password.

System ROM is bad;
system is running in
FailSafe Boot Block
mode (indicated by
eight Power LED
flashes).

Reflash the ROM using a ROMPaq
diskette.

Fixed-sync monitor will
not sync at the
resolution chosen.

Ensure that the monitor can accept
the same horizontal scan rate as the
resolution chosen.

Computer is in

standby mode.

Press the power button to resume
from standby mode.

CAUTION: When attempting to resume from standby mode, do not hold down the

power button for more than four seconds. Otherwise, the computer will shut down and

you will lose your data.

Monitor cable plugged
info the wrong
connector.

If the computer system has both

an integrated graphics connector
and an AGP card connector, plug
the monitor cable into the AGP card
connector.

Monitor settings in the
computer are not
compatible with the
monitor.

1. Restart the computer and press
F8 during startup when you see
“Press F8” in the bottom right
corner of the screen.

2. Using the keyboard arrow keys,
select Enable VGA Mode
and press Enter.

3. In Windows Control Panel,
double-click the Display icon
and select the Settings tab.

4. Use the sliding control to reset
the resolution.
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Solving Display Problems (Continued)

Problem

Cause

Solution

Power LED flashes Red six
times, once every second,
followed by a two second
pause.

Pre-video graphics
error.

For systems with a graphics card:
1. Reseat the graphics card.
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated
graphics, replace the system board.

Monitor does not function
properly when used with
energy saver features.

Monitor without energy
saver capabilities is

being used with energy
saver features enabled.

Disable monitor energy saver
feature.

Dim characters.

The brightness and
contrast controls are not
set properly.

Adjust the monitor brightness and
contrast controls.

Cables are not properly
connected.

Check that the graphics cable is
securely connected to the graphics
card and the monitor.

Blurry video or requested
resolution cannot be set.

If the graphics controller
was upgraded, the
correct video drivers
may not be loaded.

Install the video drivers included in

the upgrade kit.

Monitor is not capable
of displaying requested
resolution.

Change requested resolution.

The picture is broken up,
rolls, jitters, or flashes.

The monitor connections
may be incomplete or
the monitor may be
incorrectly adjusted.

1. Be sure the monitor cable is
securely connected to the
computer.

2. In a two-monitor system or if
another monitor is in close
proximity, be sure the monitors
are not interfering with each
other’s electromagnetic field by
moving them apart.

3. Fluorescent lights or fans may
be too close to the monitor.

Monitor needs to be
degaussed.

Degauss the monitor.

Vibrating or rattling noise

coming from inside a CRT
monitor when powered on.

Monitor degaussing coil
has been activated.

None. It is normal for the
degaussing coil to be activated
when the monitor is powered on.

Clicking noise coming from

inside a CRT monitor.

Electronic relays have
been activated inside

None. It is normal for some monitors
to make a clicking noise when

the monitor. turned on and off, when going in
and out of standby mode, and when
changing resolutions.
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Solving Display Problems (Continued)

Problem

Cause

Solution

High pitched noise coming
from inside a flat panel
monitor.

Brightness and/or
contrast settings are too

high.

Lower brightness and/or contrast
settings.

Fuzzy focus; streaking,
ghosting, or shadowing
effects; horizontal scrolling
lines; faint vertical bars; or
unable fo center the picture
on the screen.

(flat panel monitors using
an analog VGA input
connection only)

Flat panel monitor’s
infernal digital
conversion circuits may
be unable to correctly
interpret the output
synchronization of the
graphics card.

1. Select the monitor’s Auto-
Adjustment option in the
monitor’s on-screen display
menu.

2. Manually synchronize the Clock
and Clock Phase on-screen
display functions. Download
SoftPag SP20930 or SP22333,
depending on the monitor, to
assist with the synchronization.

NOTE: Use the monitor model
number when searching for the

SoftPaq.

Certain typed symbols do
not appear correct.

The font you are using
does not support that
particular symbol.

Use the Character Map to locate the
and select the appropriate symbol.
Click Start > All Programs >
Accessories > System Tools >
Character Map. You can copy
the symbol from the Character Map
info a document.

Service Reference Guide, dx2200 MT

415606-001



Troubleshooting Without Diagnostics

Solving Audio Problems

Solving Audio Problems

Problem

Cause

Solution

Sound does not come
out of the speaker or
headphones.

Software volume control
is turned down.

Double-click the Speaker icon on
the taskbar and use the volume
slider to adjust the volume.

The external speakers
are not turned on.

Turn on the external speakers.

External speakers
plugged info the wrong
audio jack.

See the sound card documentation
for proper speaker connection.

Audio cable not
connected.

Connect audio cable between CD
or DVD-ROM drive and the system
board.

Digital CD audio is not
enabled.

Enable digital CD audio:

1. From the Control Panel, select
System.

2. On the Hardware tab, click
the Device Manager button.

3. Right-click on the CD/DVD
device and select Properties.

4. On the Properties tab, make
sure “Enable digital CD
audio for this CD-ROM
device” is checked.

Headphones or devices
connected to the line-
out connector mute the
internal speaker.

Turn on and use headphones or
external speakers, if connected, or
disconnect headphones or external
speakers.

Volume is muted.

1. From the Control Panel
program, click Sound,
Speech and Audio
Devices, then click Sounds
and Audio Devices.

2. Click the Mute check box to
remove the check mark from
the box.

Computer is in

standby mode.

Press the power button to resume
from standby mode.

A CAUTION: When attempting to resume from standby mode, do not hold down the

power button for more than four seconds. Otherwise, the computer will shut down and

you will lose your data.
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Solving Audio Problems (Continued)

Problem

Cause

Solution

Noise or no sound comes
out of the speakers or
headphones.

1. If using digital speakers that

have a stereo jack and want the
system to auto-switch to digital,
use a stereo-to-mono adapter
to properly engage the auto-
sense feature or use the
multimedia device properties

to manually switch the audio
signal from analog to digital.

. If the headphones have a mono

jack, use the multimedia device
properties to switch the system
to analog out.

@y, Fyou set di?itod as the Output Mode, the internal speaker and external analog
il

speakers w
analog mode.

no longer output audio until you switch back to an auto-sense or

If you set analog as the Output Mode, external digital speakers will not function
until you change the output mode back to an auto-sense or digital mode.

Sound cuts in and out.

Processor resources are
being used by other

open applications.

Shut down all open processor-
intensive applications.

Computer appears to be
locked up while recording
audio.

The hard disk may be

full.

1. Before recording, make sure

there is enough free space on

the hard disk.

2. Try recording the audio file in a

compressed format.
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Solving Printer Problems

Solving Printer Problems

Problem

Cause

Solution

Printer will not print.

Printer is not turned on
and online.

Turn the printer on and make sure it
is online.

The correct printer
driver for the
application are not
installed.

1. Install the correct printer driver
for the application.

2. Try printing using the MS-
DOS command:
DIR C:\ > [printer port]

where [printer port] is the
address of the printer being
used. If the printer works, reload
the printer driver.

If you are on a network,
you may not have made
the connection to the
printer.

Make the proper network
connections to the printer.

Printer may have failed.

Run printer self-test.

Printer will not turn on.

The cables may not be
connected properly.

Reconnect all cables.

Printer prints garbled
information.

The correct printer
driver is not installed.

Install the correct printer driver for
the application.

The cables may not be
connected properly.

Reconnect all cables.

Printer memory may be
overloaded.

Reset the printer by turning it off for
one minute, then turn it back on.

Printer is offline.

The printer may be out
of paper.

1. Check the paper tray and refill it
if it is empty.

2. Select online.
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Solving Keyboard and Mouse Problems

Solving Keyboard Problems

Problem

Cause

Solution

Keyboard commands and
typing are not recognized
by the computer.

Keyboard connector
is not properly
connected.

1. Turn off the computer.

2. Reconnect the keyboard to the
back of the computer and
restart the computer.

Program in use has
stopped responding
to commands.

Shut down the computer using
the mouse and then restart the
computer.

Keyboard needs
repairs.

Replace the keyboard.

Computer is in

standby mode.

Press the power button to resume
from standby mode.

CAUTION: When attempting to resume from standby mode, do not hold down the
power button for more than four seconds. Otherwise, the computer will shut down and

you will lose your data.

Cursor will not move using
the arrow keys on the
keypad.

The Num Lock key

may be on.

Press the Num Lock key. The
Num Lock light should not be on if
you want fo use the arrow keys. The
Num Lock key can be disabled
(or enabled) in Computer Setup.

Mouse does not respond to
movement or is too slow.

Mouse connector is
not properly plugged
into the back of the
computer.

1. Shut down the computer using
the keyboard.

2. Plug the mouse connector into
the back of the computer (or the
keyboard) and restart the
computer.

Program in use has
stopped responding
to commands.

Shut down the computer using the
keyboard and then restart the
computer.

Mouse needs repairs.

Replace the mouse.

Computer is in
standby mode.

Press the power button to resume
from standby mode.

CAUTION: When attempting to resume from standby mode, do not hold down the
power button for more than four seconds. Otherwise, the computer will shut down and

you will lose your data.

Mouse will only move
vertically or horizontally, or
movement is jerky.

Mouse roller ball and/
or rotating encoder
shafts are dirty.

Remove roller ball cover from the
bottom of the mouse and clean both
the roller ball and the rotating
encoder shaft.
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Solving Hardware Installation Problems

You may need to reconfigure the computer when you add or remove hardware, such as an
additional diskette drive. If you install a plug and play device, Windows XP automatically
recognize the device and configure the computer. If you install a non—plug and play device, you
must reconfigure the computer after completing installation of the new hardware. In Windows
2000, select the Add New Hardware icon in the Control Panel (for Windows XP, use the Add
Hardware Wizard) and follow the instructions that appear on the screen.

Solving Hardware Installation Problems

Problem

Cause

Solution

A new device is not
recognized as part of
the system.

Device is not seated or
connected properly.

Ensure that the device is properly
and securely connected and that
pins in the connector are not
bent down.

Cable(s) of new
external device are
loose or power cables
are unplugged.

Ensure that all cables are properly
and securely connected and that
pins in the cable or connector are
not bent down.

Power switch of new
external device is not
turned on.

Turn off the computer, turn on the
external device, then turn on the
computer to integrate the device
with the computer system.

When the system
advised you of changes
to the configuration, you
did not accept them.

Reboot the computer and follow the
instructions for accepting the
changes.

A plug and play board
may not automatically
configure when

added if the default
configuration conflicts
with other devices.

Use Windows XP Device Manager
to deselect the automatic settings for
the board and choose a basic
configuration that does not cause a
resource conflict. You can also use
Computer Setup to reconfigure or
disable devices to resolve the
resource conflict.

Computer will not start.

Wrong memory
modules were used in
the upgrade or memory
modules were installed
in the wrong location.

1. Review the documentation that
came with the system to
determine if you are using the
correct memory modules and to
verify the proper installation.

2. Observe the beeps and LED
lights on the front of the
computer. See Appendix C,
“POST Error Messages” to
determine possible causes.
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Solving Hardware Installation Problems (Continued)

Problem

Cause

Solution

Power LED flashes Red five
times, once every second,
followed by a two second
pause.

Memory is installed
incorrectly or is bad.

. Reseat DIMMs.

. Replace DIMMs one at a time to

isolate the faulty module.

. Replace third-party memory

with HP memory.

. Replace the system board.
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Solving Network Problems

These guidelines do not discuss the process of debugging the network cabling.

Solving Network Problems

Problem

Cause

Solution

Woake-on-LAN feature is

not functioning.

Woake-on-LAN is not
enabled.

Use the Network control application

to enable Wake-on-LAN.

Network driver does
not detect network
controller.

Network controller is

disabled.

Run Computer Setup and enable
network controller.

Incorrect network driver.

Check the network controller
documentation for the correct driver
or obtain the latest driver from the
manufacturer’'s Web site.

Network status link light
does not turn on or it
never flashes.

The network status
light should flash
when there is
network activity.

No active network is
detected.

Check cabling and network
equipment for proper connection.

Network controller is not
set up properly.

Use the Network control application
to verify that the device is working

properly.

Network driver is not
properly loaded.

Reinstall network drivers.

System cannot autosense
the network.

Disable auto-sensing capabilities
and force the system into the correct
operating mode.

Diagnostics reports a
failure.

The cable is not securely
connected.

Ensure that both ends of the data
cable are securely connected.

The cable is attached to
the incorrect connector.

Ensure that the cable is attached to
the correct connector.

There is a problem with
the cable or a device at

the other end of the cable.

Ensure that the cable and device at
the other end are operating
correctly.

Network controller
interrupt is shared with
an expansion board.

Under the Computer Setup
Advanced menu, change the
resource settings for the board.

The network controller
is defective.

Replace the NIC or replace the
system board if the NIC is
embedded.

Diagnostics passes, but
the computer does not
communicate with the
network.

Network drivers are

not loaded, or driver
parameters do not match
current configuration.

1. Make sure the network drivers
are loaded and that the driver
parameters match the
configuration of the network
controller.

2. Make sure the correct network
client and protocol is installed.

415606-001
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Solving Network Problems (Continued)

Problem

Cause

Solution

Diagnostics passes, but
the computer does not
communicate with the
network. (continued)

The network controller
is not configured for this
computer.

Select the Network icon in the
Control Panel and configure the
network controller.

Network controller
stopped working when
an expansion board was
added to the computer.

Network controller
interrupt is shared with an
expansion board.

Under the Computer Setup
Advanced menu, change the
resource settings for the board.

The network controller
requires drivers.

Verify that the drivers were not
accidentally deleted when the
drivers for a new expansion board
were installed.

The expansion board
installed is a network card
(NIC) and conflicts with
the embedded NIC.

Under the Computer Setup
Advanced menu, change the
resource settings for the board.

Network controller stops
working without apparent
cause.

The files containing the
network drivers are
corrupted.

Reinstall the network drivers, using
the Restore Plus! CD.

The cable is not securely
connected.

Ensure that both ends of the cable
are securely attached to the correct
devices.

The network controller is
defective.

Replace the NIC or replace the
system board if the NIC is
embedded.

New network card will
not boot.

New network card may be
defective or may not meet
industry-standard
specifications.

Install @ working, industry-standard
NIC, or change the boot sequence
to boot from another source.

Cannot connect to
network server when
aftempting Remote
System Installation.

The network controller is
not configured properly.

Verify Network Connectivity, that a
DHCP Server is present, and that
the Remote System Installation
Server contains the NIC drivers for
your NIC.

System setup utility
reports unprogrammed
EEPROM.

Unprogrammed EEPROM.

Flash the ROM.

Service Reference Guide, dx2200 MT

415606-001



Troubleshooting Without Diagnostics

Solving Memory Problems

CAUTION: For those systems that support ECC memory, HP does not support mixing ECC and non-ECC
memory. Otherwise, the system will not boot the operating system.

Solving Memory Problems

Problem

Cause

Solution

System will not boot or
does not function properly
after installing additional
memory modules.

Memory module is not
the correct type or
speed or the new
memory module is not
seated properly.

Replace module with the correct
industry-standard device for the
computer.

ECC memory modules are not
supported.

Out of memory error.

Memory configuration
may not be set up
correctly.

Use the Device Manager to check
memory configuration.

You have run out of
memory to run the
application.

Check the application
documentation to determine the
memory requirements.

Memory count during POST

is wrong.

The memory modules
may not be installed
correctly.

Check that the memory modules
have been installed correctly and
that proper modules are used.

Insufficient memory error
during operation.

Too many Terminate
and Stay Resident
programs (TSRs) are
installed.

Delete any TSRs that you do
not need.

You have run out of
memory for the
application.

Check the memory requirements for
the application or add more
memory to the computer.

Power LED flashes Red five
times, once every second,
followed by a two second
pause.

Memory is installed
incorrectly or is bad.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to
isolate the faulty module.

3. Replace third-party memory
with HP memory.

4. Replace the system board.
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Solving Processor Problems

Solving Processor Problems

Problem Cause Solution
Poor performance is Processor is hot. 1. Make sure the airflow to the
experienced. computer is not blocked.

2. Make sure the fans are
connected and working
properly (some fans only
operate when needed).

3. Make sure the processor
heatsink is installed properly.
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Solving CD-ROM and DVD Problems

Solving CD-ROM and DVD Problems

Problem

Cause

Solution

System will not boot from

CD-ROM or DVD drive.

The CD-ROM or DVD
boot is not enabled
through the Computer
Setup utility.

Run the Computer Setup utility and
enable booting to removable media
and verify boot order settings.

Non-bootable CD in
drive.

Try a bootable CD in the drive.

CD-ROM or DVD devices
are not detected or driver is
not loaded.

Drive is not connected
properly or not properly
configured.

1. Reconnect power and data
cables to the drive.

2. Install correct device driver.

Movie will not play in the
DVD drive.

Movie may be
regionalized for a
different country.

See the documentation that came

with the DVD drive.

Decoder software is not
installed.

Install decoder software.

Cannot eject compact disc
(tray-load unit).

Disc not properly seated
in the drive.

1. Turn off the computer and insert
a thin metal rod into the
emergency eject hole and push
firmly.

2. Slowly pull the tray out from the
drive until the tray is fully
extended, then remove the disc.

CD-ROM, CD-RW, DVD-
ROM, or DVD-R/RW drive
cannot read a disc or takes
too long to start.

CD has been inserted
upside down.

Re-insert the CD with the label
facing up.

The DVD-ROM drive
takes longer to start
because it has to
determine the type of
media played, such as
audio or video.

Wait at least 30 seconds to let the
DVD-ROM drive determine the type
of media being played. If the disc
still does not start, read the other
solutions listed for this topic.

CD or DVD disc is dirty.

Clean CD or DVD with a CD
cleaning kit.

Windows does not
detect the CD-ROM or
DVD-ROM drive.

1. Use Device Manager to remove
or uninstall the device in
question.

2. Restart the computer and let
Windows detect the device.
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Solving CD-ROM and DVD Problems (Continued)

Problem

Cause

Solution

Recording audio CDs is

difficult or impossible.

Wrong or poor quality
media type.

1. Try using a slower recording
speed.

2. Verity that you are using the
correct media for the drive.

3. Try a different brand of media.
Quality varies widely between

manufacturers.
Solving Drive Key Problems
Solving Drive Key Problems
Problem Cause Solution

Drive Key is not seen as a
drive letter in Windows XP.

The drive letter after the
last physical drive is not
available.

Change the default drive letter for
the Drive Key in Windows XP.

The computer boots to DOS
after making a bootable
Drive Key.

Drive Key is bootable.

Install the Drive Key after the
operating system boots.

Solving Internet Access Problems

Solving Internet Access Problems

Problem

Cause

Solution

Unable to connect to the
Internet.

Internet Service Provider
(ISP) account is not set

up properly.

Verify Internet settings or contact the
ISP for assistance.

Modem is not set up
properly.

Reconnect the modem. Verify the
connections are correct using the
quick setup documentation.

Web browser is not set
up properly.

Verify that the Web browser is
installed and set up to work with
your |SP.

Cable/ DSL modem is
not plugged in.

Plug in cable/DSL modem. You
should see a “power” LED light on
the front of the cable/DSL modem.
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Solving Internet Access Problems (Continued)

Problem

Cause

Solution

Unable to connect to the
Internet. (continued)

Cable/DSL service is
not available or has
been interrupted due to
bad weather.

Try connecting fo the Internet at a
later time or contact your ISP. (If the
cable/DSL service is connected, the
“cable” LED light on the front of the
cable/DSL modem will be on.)

The CAT5 10/100

cable is disconnected.

Connect the CAT5 10/100 cable
between the cable modem and the
computers’s RJ-45 connector. (If the
connection is good, the “PC” LED
light on the front of the cable/DSL

modem will be on.)

IP address is not
configured properly.

Contact the ISP for the correct IP
address.

Cookies are corrupted.

Windows XP

1. Select Start > Control
Panel.

2. Double-click Internet
Options.

3. On the General tab, click the
Delete Cookies button.

Cannot automatically
launch Internet programs.

You must log on to the
ISP before some
programs will start.

Log on to the ISP and launch the
desired program.
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Solving Internet Access Problems (Continued)

Problem

Cause

Solution

Internet takes too long to
download Web sites.

Modem is not set up
properly.

Verify that the correct modem speed
and COM port are selected.

For Windows XP

1.

Select Start > Control
Panel.

. Double-lick System.
. Click the Hardware tab.

. In the Device Manager areq,

click the Device Manager
button.

. Double-click Ports (COM &

LPT).

. Right-click the COM port your

modem uses, then click
Properties.

. Under Device status, verify

that the modem is working
properly.

. Under Device usage, verify

the modem is enabled.

. If there are further problems,

click the Troubleshoot button
and follow the on-screen
instructions.
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POST Diagnostic Front Panel LEDs and Audible Codes

This section covers the front panel LED codes as well as the audible codes that may occur before
or during POST that do not necessarily have an error code or text message associated with them.

% If you see flashing LEDs on a PS/2 keyboard look for flashing LEDs on the front panel of the
computer and refer to the following table to determine the front panel LED codes.

% Recommended actions in the following table are listed in the order in which they should be
performed.

Diagnostic Front Panel LEDs and Audible Codes

Activity Beeps Possible Cause Recommended Action

Green Power LED None  Computer on. None

On.

Green Power LED None  Computer in None required. Press any key or move the

flashes every two Suspend to RAM  mouse to wake the computer.

seconds. mode (some
models) or normal
Suspend mode.

Power LED flashes None  Processor thermal 1. Ensure that the computer air vents are

every four seconds. protection not blocked and the processor
activated: cooling fan is running.
A fan may be 2. Open hood, press power button, and
blocked or not see if the processor fan spins. If the
turning. processor fan is not spinning, make
OR sure the fan's cable is plugged onto
The heatsink/fan the system board header. Ensure the
assembly is nof fon is fully/properly seated or
properly attached installed.
to the processor. 3. If fan is plugged in and seated

properly, but is not spinning, then
replace processor fan.

4. Reseat processor heatsink and verify
that the fan assembly is properly
attached.

5. Contact an authorized reseller or
service provider.

Power LED flashes ~ None  Pre-video memory 1. Reseat DIMMs. Power on the system.

five times, once
every second,
followed by a two
second pause.

error.

2. Replace DIMMs one at a time to
isolate the faulty module.

3. Replace third-party memory with HP
memory.

4. Replace the system board.
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Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps Possible Cause Recommended Action
Power LED flashes ~ None  Pre-video graphics  For systems with a graphics card:
six fimes, once error. 1. Reseat the graphics card. Power on
every second, the system.
followed by a two .
second pause. 2. Replace the graphics card.
3. Replace the system board.
For systems with integrated graphics,
replace the system board.
Power LED flashes ~ None  Invalid ROM 1. Reflash the ROM using a ROMPaq
eight times, once based on bad diskette.
every second, checksum. 2. Replace the system board.
followed by a two
second pause.
System does not None  System unableto  Press and hold the power button for less

power on and LEDs
are not flashing.

power on.

than 4 seconds. If the hard drive LED turns
green, then:

1. Check that the voltage selector,
located on the rear of the power
supply, is set to the appropriate
voltage. Proper voltage setting
depends on your region.

2. Remove the expansion cards one at a
time until the LED light on the system
board turns on.

3. Replace the system board.
OR
Press and hold the power button for less

than 4 seconds. If the hard drive LED does

not turn on green then:

1. Check that the unit is plugged into a
working AC outlet.

2. Open hood and check that the power
button harness is properly connected
to the system board.

3. Check that both power supply cables
are properly connected to the system

board.

4. Check to see if the LED light on the
system board is turned on. If it is
turned on, then replace the power
button harness.

5. If the LED light on the system board is
not turned on, then replace the power
supply.

6. Replace the system board.
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4-pin power pin assignments A—4
24-pin power pin assignments A—4
5.25

drive bezel blank 64

A

access panel, removal and replacement 6-2

ATA/ATAPI (IDE) drive cable pin assignments A—
4

battery

real-time clock E-2

removal and replacement 6-25 to 6-28
bezel blank, 5.25" drive 64
blank screen E-9

C

cable connections 6—11
cable management 6-10
cable pinouts

PATA data 4-3

PATA power 4-3

SATA data 4-2

SATA power 4-2
cable, proper handling 5-7
cautions

AC power 5-1

adding devices 1-1

batteries 57

cables 5-7

cooling fan 5-6

installation 1-1

keyboard cleaning 5-5

keyboard keys 5-5
changing operating systems, important information

3-3

changing password 3—4
chassis, illustrated 5-1
cleaning

computer 5—4

keyboard 5-5

monitor 5-5

Index

mouse 5-5
cloning tools, software 3—1
CMOS Setup, Standard 2—4 to ??, 2-5 to 2—-6
computer
cleaning 54
pauses E-2
Computer Setup
Standard CMOS Setup 2—4 to 7?, 2-5 to 2-6
system information 2—4
utilities 2-2
configuring power button 3-2
connector pin assignments A—1 to A—4
country-specific power cord set requirements B—2
customizing software 3—1

date and time display E-2

deleting password 3-5

deployment tools, software 3—1

device drivers
installing/upgrading 1-1
obtaining 1-2

disassembly preparation 6—1

disk, cloning 3-1

drive
5.25" removal and replacement 6—13
capacities 4-5
hard drive removal and replacement 6—16
partition size 4-5

drive bezel 64

Drive Key, problems E-23

drive positions 612

dual-state power button 3—-2

electrostatic discharge. See ESD
energy savings, settings for 3-2
entering
supervisor password 3—4
user password 3—4
error messages, POST C-1 to C-5
ESD (electrostatic discharge)
information 5-2
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Index

materials and equipment 5-3
preventing damage 5-2
Ethernet
RJ-45 pin assignments A—1
expansion card removal and replacement 6—8

expansion slot cover lock removal and replacement

6-8

F

FailSafe Boot Block ROM 3-1

fan, power supply 5-6

FAT 32 to NTFS conversion 1-2

flashing LEDs C-5

4-pin power pin assignments A—4

front bezel removal and replacement 6-3
front drive bezel 64

front I/O panel removal and replacement 617

G
grounding methods 5-3

H

hard drive

proper handling 5-7

removal and replacement 6—16
headphone pin assignments A-3
heatsink removal and replacement 6-21

initial configuration 3-1
Internet addresses, See Web sites

K

keyboard
cleaning 5-5
pin assignments A—1

L
LEDs

blinking PS/2 keyboard C-5
line-in audio pin assignments A—3
line-out audio pin assignments A—3

M

memory, removal and replacement 6-6
microphone pin assignments A—2
monitor

blank screen E-9

blurry video E-10

checking connections E~1

cleaning 5-5

dim characters E-10

pin assignments A-3

mouse
cleaning 5-5
pin assignments A—1

N
NTES conversion 1-2

o

operating systems, important information about 3—
3

P

parallel interface pin assignments A—2
password

changing 34

deleting 3-5

power-on 2—1

setup 3-3

supervisor 3—4

user 3—4
password security 3-3
PATA

data cable pinouts 4-3

power cable pinouts 4-3
POST (Power-On Self-Test) 2—-1
POST error messages C—1 to C-5
power button

configuring 3-2

dual-state 3-2
power cord set requirements

country specific B-2

general B—1
Power Management 3-2
power supply

fan information 5-6

removal and replacement 6-29

surge-tolerant 3—5
power switch assembly removal and replacement

6-18

power-on password 2—1
Power-On Self-Test (POST) 2-1
preinstalled software image 3-1
preparation for disassembly 6—1
problems

audio E-12

CD-ROM and DVD E-22

diskette E-5

display E-9

Drive Key E-23

hard drive E-6

installing hardware E-16
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Index

Internet access E-23
keyboard E-15
memory E-20
network E—18
optical drives E-22
power supply E—+4
printer E-14
processor removal and replacement 622

recovering system 3—1
recovery, software 3—1
removal and replacement
<$Startrange 6-25 to ??
5.25" drive 6-13
access pannel 6-2
battery 7?7 to 6-28
expansion card 68
expansion slot cover lock 6—8
front bezel 6-3
front I/O panel 6-17
hard drive 6-16
heatsink 6-21
memory 6-6
power supply 629
power switch assembly 6-18
processor 622
speaker 6-19
system board 6-24
system fan 6-20
required tools and software 5-6

S
safety precautions, cleaning 54
SATA
data cable pinouts 4-2
power cable pinouts 4-2
saving energy 3-2
screws, correct size 5-6
SDRAM (synchronous dynamic random access
memory) D-1
serial interface pin assignments A—2
service considerations 5—-6
setting
supervisor password 3-3, 3—4
timeouts 3-2

setup

initial 3—1

MS Windows 1-1

software 1-2
software

Computer Setup Utilities 2—1

FailSafe Boot Block ROM 3-1

integration 3—1

Power Management 3-2

recovery 3-1

required 5-6

setup 1-2
spare part number, tamper-resistant wrench 5-6
speaker, removal and replacement 6—19
static electricity 5-2
supervisor password

changing 34

deleting 3-5

entering 3—4

setting 3-3
surge-tolerant power supply 3-5
system board removal and replacement 624
system fan, removal and replacement 620
system information, Computer Setup 2—4
system recovery 3—1

T

timeouts, setting 3—2
tools, required 5-6
24-pin power pin assignments A—4

U

USB pin assignments A-2
user password

changing 34

deleting 3-5

entering 3—4

w
Wake-on-LAN feature E-18
warning, battery 5-7
Web sites

HP 12

HP support 1-1, 3-3

PC Deployment 3—1
wrench, tamper-resistant 5-6
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